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About this guide

This document describes the integration of XA with Infor LTR using System i Workspace AnyWhere,
referred to as SiWA in the rest of this guide. This guide explains the integration requirements,
configuration tasks, and troubleshooting information.

Intended audience

This guide is intended for the system administrator or professional service consultant who configures
the integration between SiWA and Infor LTR.

Required knowledge

To integrate XA and Infor LTR, you must understand the concepts behind System Manager, SiWA,
and Infor LTR.

Related documents

You can find the documents in the product documentation section of the Infor Support Portal, as
described in "Contacting Infor" on page 8.

These guides are also needed if the initial installation is not already completed:

Infor System Manager Quick Installation Guide for Infor XA

Infor XA Setup Guide for Secure Net-Link

Infor Local Technology Runtime Installation Guide

Infor Si System Manager Installation Guide

System i Workspace AnyWhere Installation and Administration Guide

KB1365947 — Need Authorization codes
KB1136739 — System Manager and Work Management PTFs
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https://customerportal.infor.com/csmcore?id=kb_article_view&sysparm_article=KB1365947
https://support.infor.com/espublic/EN/AnswerLinkDotNet/SoHo/Solutions/SoHoViewSolution.aspx?SolutionID=1365947&kb_is_archived=0&kb_accessed_from=KBSearchResult
https://customerportal.infor.com/csmcore?id=kb_article_view&sysparm_article=KB1136739
https://support.infor.com/espublic/EN/AnswerLinkDotNet/SoHo/Solutions/SoHoViewSolution.aspx?SolutionID=1136739&kb_is_archived=0&kb_accessed_from=KBSearchResult

+  KB1963350 — System i Workspace AnyWhere

Contacting Infor

If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and
create a support incident.

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To access
documentation on docs.infor.com, look under ERP & Finance > XA. We recommend that you check
this portal periodically for updated documentation.

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1 Introduction

Infor Local Technology Runtime (LTR) is a comprehensive platform for social collaboration, business
process improvement, and contextual analytics. You get the most innovative social collaboration
technologies translated into a business environment, fully integrated across your business
processes.

System i Workspace AnyWhere (SiWA) is the user interface for Infor XA.
The user interface includes these components:

* Most XA IDF objects that are available in IDF Net-Link.

+ XAIDF Level 1 tasks that were previously only available through green screen and Host
Presentation Server in Power-Link.

+ SiWA, an intermediate layer. This layer is required because the NetLink user interface is not
displayed as tabbed content directly within the frame of Infor LTR.

« Within SiWA, both Net-Link and IDF L1 user interfaces are rendered as tabbed content.

This guide describes the process to configure the components required to run XA within the Infor
LTR common user interface.

These are the recommended sequence of steps to complete the installation and configuration:

1 Infor XA server and client with Net-Link

N

Infor System i System Manager
3 Infor System i Workspace AnyWhere
4 Infor Local Technology Runtime (LTR)

These examples show the System i Workspace AnyWhere in Infor LTR:
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Infor Development Framework Customer Orders and Quotes

Context App Primary View A

Customer Orders and Quotes o e
[® | Filea Displays Maintain | |Customize 4 | Help 4 General (all records) QRD&LO™m PRLMTDO e Siling
Coas Order Status Customer  Name Whs  Orderdale w Reference Sales Contract  Re &3 Price 2014 [0

2 CO 20190  10=Enterec 10007602 Hyderabad SCE 032412023 0 040 Price code. 05 = Price 05
2 CO 20189  15=Noline: 10007602 Hyderabad SCE 032412023 0 040 Contract. 0
2 CO 20188  15=No line: 10007602 Hyderabad SCE 0312412023 0 040 Unit price discount percent  0.000
2 CO 20187  15=Noline: 10007602 Hyderabad SCE 032412023 0 0400 Fixed trade discount: ~ (blank)
2 CO 20186 10 =Enterec 10007602 Hyderabad SCE 0312412023 0 040 Trade discount percent.  0.000
2 CO 20185  15=Noline: 10007602 Hyderabad SCE 032412023 0 040 rency
2 CO 20184  10=Enterec 10007602 Hyderabad SCE 032372023 0 0400 Cumency= Glnk)
2 CO 20183  10=Enterec 10007602 Hyderabad SCE 03232023 0 040 Firenge ole dele. (biak)
2 CO 20182  10=Enterec 10007602 Hyderabad SCE 032172023 0 033 Overrido rale:: 0.000000 har
2 CO 20181  10=Enterec 10007602 Hyderabad SCE 032112023 0 033 TSR “
2 CO 20180  10=Enterec 10007602 Hyderabad SCE 032172023 0 033
2 CO 20179  10=Enterec 10007602 Hyderabad SCE 032172023 0 033 Customer Order
2 CO 20178  10=Enterec 10007602 Hyderabad SCE 032172023 0 033 Soquence i liem "
2 CO 20177  10=Enterec 10007602 Hyderabad SCE 032172023 0 033 Bl
2 CO 20176  10=Enterec 10007602 Hyderabad SCE 032172023 0 033
2 CO 20175  10=Enterec 10007602 Hyderabad SCE 031212023 0 033
2 CO 20174  10=Enterec 10007602 Hyderabad SCE 032172023 0 033
1 CO 13665  10=Enterec 100 0

Aerospace Alloys AUS 031012023 D0000034

031
Q
Infor Development Framework Maintain Purchase Order Instaliments

Actions v

Date

Purchase Order Entry/Edit A
Order Selection

Release D

Option

1 Add order/item

2 Revise order/item/release

3 Change, do not flag as revised, order/item/release
4 Cancel order/itemirelease

5 Reactivate cancelled order/item/release

6 Vendor accept

7 Reopen/Complete
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Chapter 2 Requirements

This chapter describes the requirements for configuring Infor XA with Infor LTR using SiW
Anywhere.

Infor XA Server and client with Net-Link
requirements

Install System Manager on each IBMi which runs XA environments. This is a pre-requisite for SiwW
Anywhere. Review this list to determine what you need:

* Infor Development Framework for Infor XA 06.03 (IDF R9) and any additional IDF licensed
applications like IDF Power-Link with Integrator and Net-Link.

* Infor XA IDF 9.2.2.3 client software build must be 02.09.02.02.61 or later.

* Infor XA IDF 9.2.2.3 server PTFs is PCM SH SH16252 (XA 9.2.2.3 with PTF level 25457).

* Infor XA IDF 10.0.1.1 client software build must be 03.10.00.01.34 or later.

* Infor XA IDF 10.0.1.1 server PTFs is PCM SH16275 (XA 10.0.1.1 with PTF level 00502).

* Infor XA IDF 11.0.0 client software build must be 03.11.00.01.01 or higher.

+ IBMi standard software set option 5770SS1: Option 8 — AFP Compatibility Fonts (required for
TIFF image support).

* IBMi standard software set option 5770TS1 on V7R2/R3/4 i5/0S, must have both the base
option and Option 1 installed (required for PDF support).

Additional software required for System i System Manager:
* The required OS/400 level for Infor System Manager 3.0.4 must be at least V7R3.
* Infor System Manager v3 plus latest PTF (143 minimum)

These PTFs are required to correctly generate self-signed certificates within the IBM HTTP Server
as additional software for System i Workspace with IBMi deployment:

+ 0S400 V7R2 - R720 PSY SI67104 UP18/09/12 P 8249
+ 08400 V7R3 - R730 PSY S167280 UP18/05/04 | 1000
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+ IBMJ9 VM 1.8.0 64-bit JVM (5770-JV1 option 17)

Note: This JVM version must be installed and enabled over all application servers installed
within the WebSphere profile that you intend to use with System i Workspace.

* IBM HTTP Server (latest updates required)

*  WebSphere Application Server Base v9.0.0.11 (or higher)
*  WebSphere Application Server Plugins v9.0.0.11 (or higher)

Note: You need to ensure that a default profile and server is created. The initial name of this profile
is "default" and the server name is "server1."

Infor System i System Manager requirements

Review these requirements before installation and configuration.

Software Requirements
The required OS/400 level for Infor System Manager 3.0.4 must be at least V7R3.

Note: If you are using iASPs (Independent Auxiliary Storage Pools) on your IBMi machine, you must
contact an Infor Consultant to discuss how to proceed with your System i Workspace installation.

Security requirements for IBMi accounts

These user accounts must be created if not already present on your IBMi server. If the accounts
already exist, then ensure that their security configuration matches these specifications.

User Requirement

Security Officer User with sufficient authorities to This user must have a profile with *ALLOBJ
install System i System Manager (the install must and *SECADM special authorities to be able
default to QSECOFR) to install System i Workspace.

14 | Infor XA Configuration Guide for Infor LTR using System i Workspace AnyWhere



Infor System i Workspace AnyWhere Requirements

SiW AnyWhere can be installed with Windows or IBMi deployments. One SiW AnyWhere server can
support multiple XA machines or environments, or you can use multiple SiW servers.

Note: After you complete the SiW AnyWhere installation, update the installation with latest Feature
Pack version. FP10 is the minimum required version for this implementation.

Hardware requirements

See “Hardware requirements and recommendations” section from “Chapter 2 Preparing for the
installation” in System i Workspace AnyWhere Installation & Administration Guide.

Software requirements

See “Software requirements” section from “Chapter 2 Preparing for the installation” in System i
Workspace AnyWhere Installation & Administration Guide

Security and account requirements

This section covers the IBMi and SSL/TLS encryption requirements.

IBMi accounts required

These user accounts must be created if not already present on your IBMi server. If the accounts
already exist, ensure that their security configuration complies with these specifications.

User Requirement

Security Officer User with Sufficient authorities to This user must have a profile with*ALLOBJ
install System i Workspace. The installation will and SECADM* special authorities to be able
default to QSECOFR. to install System i Workspace.

Database User to access System Manager, WFi If an account does not exist, the installer will
files depending on the version of System Manager create an account and configure the account
you selected. The installation will default to per the requirements.

JDBC_AMV3.
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This user must have a Group Profile of initial program, which should include the

AULUSER, Supplemental Groups of System Manager libraries as part of their
AULSECOFR, AULEXTOWN, AULAMDBUSR and initial library list.

(PWDEXPITV) set to *NOMAX. Note: If you are using iASPs (Independent
It is also recommended that this user is set to Auxiliary Storage Pools) on your IBMi
*SIGNOFF for security reasons. machine, you should contact an Infor

This user should also have a library list set up Consultant to discuss how to proceed with
either by defining the job description or using an your System i Workspace installation.

Requirements

User Requirement

This Database User must have enough
authority to read the Spool, Message and Job
queues of all IBMi users that have access to
the My Spool Files, My Jobs and My
Messages widgets, along with authority to
carry out certain actions on their behalf such
as delete a Spool File. This authority will not
be enabled by the installer and must be
applied manually.

SSL/TLS encryption

System i Workspace uses SSL/TLS encryption for all communication over HTTP between the Client
and Server. You can select one of these options from the System i Workspace installer:

+ Self-Signed Certificate, which is created automatically by the installer.
+ Certificate Authority, if performing a Microsoft Windows deployment, use one that has been
purchased or generated such as Comodo, Symantec or from one of the many other providers.

If you are using a certificate from a Certificate Authority, you need these items during the installation
of System i Workspace:

* AKeystore file that contains your purchased SSL Certificate and a full Certificate Authority
Chain

* The password to this Keystore file

* The Alias Name for this Certificate within the Keystore file

See “Secure Sockets Layer (SSL)” section from “Chapter 14 Security” in System i Workspace
AnyWhere Installation & Administration Guide for additional details regarding how to obtain these
items before you begin installation of Infor SiWA.

IBMi deployment

Ensure the appropriate PTF for your IBMi Operating System, documented in the Software
Requirements section, is applied.
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See IBMi deployment section of the Prerequisite installations chapter for more information on
configuring SSL before installing Infor SiWA .

Infor LTR requirements

This section describes the server requirements for Infor Local Technology Runtime (Infor LTR).
Note: Infor LTR 2024.12 is the minimum version required for successful integration.

See the latest Infor Local Technology Runtime Installation Guide for a better understanding of
requirements and installation of Infor LTR.
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Chapter 3 Installation

This chapter provides information on System Manager, SiWA, and Infor Local Technology Runtime
installations.

Installing System Manager

For the complete set of instructions required to install System Manager, see Infor System Manager
Quick Installation Guide for Infor XA on docs.infor.com under version 9.1.

For additional information, see Infor Si System Manager Installation Guide.

Installing System i Workspace AnyWhere

This section describes the process of SiWA installation for both Microsoft Windows and IBMi
deployments.

Microsoft Windows deployment

For installation and configuration of SiWA to run on Tomcat Web Server, see Infor System i
Workspace AnyWhere Installation and Administration Guide and follow all the steps related to
Microsoft Windows deployment.

Note: If you want to install and run multiple instances of SiWA in a single Windows server using
unique ports for each individual installation, see the required additional settings mentioned in

Infor XA Configuration Guide for Infor LTR using System i Workspace AnyWhere | 19



IBMi deployment

For installation and configuration of SiWA to run on WebSphere Application Server, see Infor System
i Workspace AnyWhere Installation and Administration Guide and follow all the steps related to IBMi
deployment.

Refer to these sections for any issues or missing steps observed during this deployment process:

* Chapter 3 Pre-requisite installations -> IBM i deployment -> Creating a local Certificate of
Authority section in the Infor System i Workspace AnyWhere Installation and Administration
Guide can include the Select Applications page. Select all applications on this page that have
your XA IBMi server in the Assigned Certificate column.

* In Chapter 3 Pre-requisite installations -> IBM i deployment -> Creating an IBM HTTP Server
instance section in the Infor System i Workspace AnyWhere Installation and Administration
Guide, verify that the default WebSphere profile is displayed in the application list. If not, see the
Creating an additional default WebSphere Profile section in this chapter to create the default
profile in WebSphere.

+ After selecting the default WebSphere profile, if a message of Indicate which installed
application should be mapped to the selected Web Server displays, select the Default
Applications only value.

+ After successful installation of SiWA on WebSphere, if you receive an Internal Server Error
when you try to launch the SiWA for the first time, refer to Appendix C in this guide.
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Integration data sheet

During the installation and the configuration tasks, you are prompted for information in this table.
Prior to installation, print this table and fill in the applicable information.

Data Your value

System Name

System i server on which Infor XA is installed
Identify one server as the default

User ID
System i log-on User ID for an account on the
machine on which ERP XA is installed. For the

Account, the supplemental group authority must be
AULSECOFR

Installation

Data Your value

Password
Password for the System i user ID

Net-Link URL

IDF environment code

You can gather some of the information, such as server names and log-ons, before you begin the
installation. You can fill in the remaining data as you proceed through the installation so that you
have the required data when prompted.
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Installing Infor Local Technology Runtime

We recommend that you use XA with System i Workspace and Infor LTR installed.

You can use XA with System i Workspace but without Infor LTR. During installation, you can omit the
Infor LTR installation and configuration steps, but you must complete these steps:

* Install System Manager.
* Install System i Workspace.
* Export the metadata.

You can then access System i Workspace directly using a standalone URL as described in the
System i Workspace AnyWhere Installation & Administration Guide.

You must verify the System i Workspace function even if you plan to use Infor LTR.

For the complete set of instructions required to install Infor LTR, see the Infor LTR Installation Guide.
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Chapter 4 Post installation

This chapter provides the post-installation information for SiWA.

System i Workspace AnyWhere

Refer to the System i Workspace AnyWhere Installation & Administration Guide for detailed
information about the tasks in this section.

Verifying the installations

After the installation of all the components, you must execute the process described in the “Verifying
the System i Workspace deployment” section of the System i Workspace AnyWhere Installation &
Administration Guide.

Setting the iIASP

If your XA environment is on an iASP, execute these processes to ensure that the iIASP group is set
to the correct iASP:

1 Specify STRM400 on the AS400 screen to start the System Manager.
2 SelectApplication Manager and press Enter.

3 SelectMaintain Environments and press Enter.

4 Press F4 and select Environment.

5 Ensure that the iIASP group is set to the correct iIASP.
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Maintain Environments

Environment QQ *UPDATE

Type in details and press ENTER to update

Environment name. . . . . . 9.2 - Build testing w/IFM
Environment group ? . . . . 9.2 - Build testing w/IFM

Role processing . . . . . . C (0-No, 1-Yes)
iASP group. S BB e g IASI
Ming.le active. . = = un & (O-No, 1-Yes)

F3=Exit F4=Prompt Fl11=Delete F12=Previous Fl4=Work Management

Securing Net-Link and Secure Socket Layer configuration

The standard installation process involves secure socket layer (SSL) configuration and accessing
Net-Link through a URL to the IBMi. This configuration restricts user access to a secure network.

Microsoft Windows deployment

For SSL configuration, complete the process described in the “Chapter 14 Security” section in the
System i Workspace AnyWhere Installation & Administration Guide.

To set up a secured Net-Link in the SiWA application, follow the steps in Infor XA Setup Guide for
Secure Net-Link.

1 Generate war file by referring to the WAR file generation section.

2 Deploy the war file on SiWA Tomcat by referring to the WAR file deployment -> Tomcat (version
7.0 +) section.

3 Configure the Net-Link URL in SiWA Admin.html by referring to Appendix B Workspace Net-Link
URL configuration.
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Client settings

This section explains the client settings that need to be configured on each client PC that accesses
the SiWA. See “Chapter 8 Client settings" in the System i Workspace AnyWhere Installation &
Administration Guide.

System i Workspace profiles

We recommend that you set one SiWA profile for each configured XA environment.

Currently, the Tenant specified during deployment of SiWA within Infor LTR is used is the same as
the Workspace profile ID.
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Chapter 5 Exporting metadata

You can export metadata from Infor Development Framework (IDF) to SiW. This metadata contains
the information for the cards, card files, and the contents in IDF. The metadata is used by SiW to
construct the menus and the options.

Enabling host reports

Enabling the export metadata job is required to ensure that AULAMP3 is in the library list for the
environment.

1

Specify STRXA at the command on the green screen to start your XA environment and select the
required environment.

Specify CAS on the command line.
Specify AMZM70 on the command line.
Select Maintain Library List.

Add AuLAMP3 to the Library List.

Requirements

To run exports, sign in with a user ID that has supplemental group authority AULUSER and
AULSECOFR.

System Manager and SiW PTFs must be the latest versions.
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Exporting metadata from IDF to Workspace

After installations, the users need to export the metadata from IDF to SiW. The IDF metadata is the
data that describes the objects in IDF and how these objects are arranged into cards and card files.

This metadata must be converted to Si\W metadata that describes the tasks available in SiW and
how the tasks are grouped into menus.

The two interfaces use different terminology and different styles to present the application tasks
available to a user. This export process maps the IDF metadata to the SiW metadata.

Although the Net-Link interface of IDF is integrated with SiW, you can use Power-Link or release 10
of Net-Link to invoke the export process.

Export public or private metadata

The Export public metadata to Workspace host job exports the metadata for public card files,
cards, and the related objects. The host job ignores export of metadata for private card files or cards
even for the user who runs the job. However, user defined public card files, cards, and objects are
included.

If you need to export private card files and cards as well as the public ones, you are not required to
run both the public and the private export jobs. The Export private metadata to Workspace host
job includes the public card files and cards.

You can rerun either export job if card files or cards are added or modified. You must include users
when you run the host job again, or authorization to access the menu may not be valid.

The export jobs also export definitions for the environment, applications, library lists, companies, and
users.

The Export public metadata to Workspace host job is available in these cards:

* Business Objects object on the Integrator card

» User Profiles object on the Integrator card

* User Profiles object on the Environment card

The process and screenshots in this section explain the host jobs from the Business Objects object.
The process is similar for the User Profiles object.

The Export private metadata host job is only available on the User Profiles object. This host job is
very similar to the Export private metadata to Workspace host job but allows the selection of the
users to be exported.

Exporting metadata
1  Start Net-Link.
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2 Navigate to the Business Objects object on the Integrator application card or the User Profiles
object on the Integrator or Environment object.

3 Select File > Host Jobs.

The Host Job option is not displayed if System i Manager is not properly installed or the
AULAMP3 library is not added to the XA Environment library list.

4 Select the Export public metadata to Workspace tab. The tabs are displayed in alphabetical
order, but this order is not the best sequence to run them.

5 Select the Execute check box.

The Description attribute is applicable only for the logs and does not affect the exported data.

= Infor Development Framework Business Objects
Business Object

Cancel| Help

Export L1 data to Workspace O Execute

Export public metadata to Workspace m

Description:  Export public metadata to Workspace

Options
Top level menu and menu name prefix:  IDF
Top level menu description: IDF
Include users: @ Yes O No
Set user attributes

Replace menus: @ Yes O No

6 Specify the name of the top level menu that is created in the Top level menu and menu name
prefix field.

From the top level menu, you have access to all other exported menus. This name is used as a
prefix for all other exported menus to limit the length. The default top level menu is IDF. We
recommend that you use IDF unless IDF clashes with an existing menu. We recommend that
you do not run the job multiple times with different top level menu names to avoid creating
similar menus in System i Manager. If you need to delete redundant menus, use System i
Manager functions.

7 Specify the description of the Top level menu in System i Manager.
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8 Select Yes for the Include users field if the users must be included in the Export process. If you
do not include users, you must run the Export again and include the users or create the users
manually in System i Manager. If the Export job exports new menus or menu options, you must
select Yes or the authority to the menus and options will not be available in Workspace.

9 Specify Yes in the Set User Attributes field if user attributes must be set. For an XA user,
selecting Yes for this attribute is usually appropriate. The exception is when you have non-XA
tasks and menus in System i Manager. In this case, you might require an initial menu that
references the exported IDF top level menu and the non-XA tasks.

10 Specify Yes in the Replace Menus field if the menus are replaced. Select Yes to delete the
previous version of the menu and export a new version. Selecting No allows the export to run
more quickly, but if objects are removed from cards in IDF, obsolete options may remain in
System i Manager.

Selecting Yes is appropriate, except in the case of exporting additional languages.

11 Specify Yes for each language only if translated card file, card, and object descriptions must be
exported. Otherwise, leave as No. A maximum of five languages can be exported in one run. If
you need to export more than five languages, you can run the Export again with additional
languages. If you run the export host job again to add languages, you must set Replace menus
option to No or the previous translations are lost.

12 Click Submit.

The Export public and private metadata to SiW jobs run on the client; therefore, the system is slow to
respond when you click Submit.

Areport is generated with the list of exported files and list of errors, if any. This report is displayed on
the system used for the Submit process and not on the host.

Export IDF level 1 tasks

You must run the Export L1 data to Workspace host job to use IDF Level 1 tasks in SiW. The
Export L1 data to Workspace host job exports both Infor supplied, and additional user defined L1
options.

If you do not require L1 tasks in SiW, do not run this export process. The Export L1 data to
Workspace host job is available in Business Objects on the Integrator application card. The Export
L1 data to Workspace host job is also available in the User Profiles object on the Integrator or
Environment application cards. Having the Export L1 data to Workspace host job available
from the Environment application card provides access without an Integrator license.

You must run the Export public or private metadata job before executing this job or the Export L1
data to Workspace host job will fail.

Note: You must run the Export public or private metadata job again after executing this job.
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The Export L1 data to Workspace host job generates the tasks and menus required in SiW to run
user IDF L1 options.

Exporting IDF tasks

1 Start Power-Link.

2 Navigate to the Business Objects object on the Integrator card.

3 Select File > Host Jobs.

4 Select the Export L1 data to Workspace tab. The tabs are displayed in alphabetical sequence.

5 Select the Execute check box.

The Description attribute is for the logs and does not affect the exported data.

Infor Development Framework Business Objects

Business Object

Cancel| |Help

Export L1 data to Workspace O Execute

Description: Export L1 data to Workspace

Export public metadata to Workspace

Options

Menu name prefix: | IDF

Chinese: QO Yes @ No
Czech: OYes @ No
French: O Yes @ No
German: O Yes @ No
italian: O Yes @ No
Japanese: O Yes @ No
Polish: O Yes @ No
Portuguese: O Yes @ No
Spanish: O Yes @ No

Swedish: O Yes @® No

Turkish: O Yes @ No

6 Specify the prefix to use for the generated menus in the Menu name prefix field. Using the
same value as in the public or private metadata job is recommended. The generated menu
names may have the same prefix, which is not an issue.
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7 Select Yes for each language only if translated card file, card, and object descriptions must be
exported. Otherwise, leave as No.

8 Click Submit.

The Export L1 data to Workspace host job runs on the iSeries and generates a report that can be
located using WRKUSRJOB.

When the export is complete, you must run the Export public or private host job again.

In the first run of the export, the links to the L1 menus are dropped as the L1 metadata is not
available. After the L1 export, the metadata is available but not linked to the other menus. In the
second run of the public or private metadata, the links are established.

Exporting users to Workspace

In XA, an environment might be unlocked and therefore the environment can be accessed by
anyone with a valid IBM i user profile. For SiW, all the users must be authorized to use System i
Manager.

Users are exported to Workspace using the Export public metadata to Workspace host job or the
Export private metadata to Workspace host job.

If you have XA users who are not defined in the User Profiles object, we recommend that you define
the users before you run the Export users to Workspace host job. Otherwise, you must define the
users in System i Manager and authorize suitable menu authority. To define these users, select
User Profile Maintenance on the Security Maintenance in Cross Application Support, menu
AMZM38 option 5. Work With XA User Profiles.

If you use SiW to run tasks exported from IDF and run the public or private version of the Export
metadata to Workspace host job for the first time, you must set the Set user attributes to Yes.

Otherwise, the initial menu is not displayed for the users in the workspace. This is applicable for
most XA users. You can change this attribute to No for subsequent Export users to Workspace host
jobs unless you have defined additional users or additional private card files and cards.

Additional metadata maintenance

If cards or card files are changed in IDF, then you must export the metadata again if you have made
any of these changes:

* Added an object to a card
* Removed an object

* Changed the workspace of an object on a card
* Added a new card, a new card file, or changed the cards in a card file

The only Integrator change that requires a rerun of the export is a change to the business object title.

If you have not added or changed L1 user options, then you do not have to run the L1 export again.
A single run of the public or private metadata export job meets the requirement.

Infor XA Configuration Guide for Infor LTR using System i Workspace AnyWhere | 33



Re-exporting metadata from IDF to Workspace

If you make changes in IDF that affect the IDF cards such as adding additional objects or IDF L1
Tasks such as adding additional user options, then you must run the appropriate Export host jobs
again.

If your change does not affect L1 tasks, then you can run the Export public metadata to
Workspace host job or the Export private metadata to Workspace host job. Use the public or
private version depending on whether you require public cards or public and private cards file or
cards.

If your change affects L1 tasks, for example, an additional user defined L1 task, then you must run
the Export L1 data to Workspace host job. You might have to run the Export public metadata to
Workspace host job or the Export private metadata to Workspace host job afterwards. Your
action depends on whether the change requires a new link from an L2 menu to an L1 menu. We
recommend that you run the Export public metadata to Workspace host job or the Export private
metadata to Workspace host job regardless.

After these jobs, you must run the Export users again to Workspace host job to configure the
authority of the exported tasks in SiW. You are not required to use Set user attributes when
reexporting users, the job sets the menu authority whether this attribute is used. If you have
deliberately changed a user’s initial menu in System Manager, then you must specify No for Set
user attributes.

Because most of the export jobs do not support subsets, you may export more metadata than
required. This result is not usually a problem because unchanged objects, card files, and cards
export the same data as previously. If you have changed any of the exported data in System
Manager, these changes may be overwritten by a re-export. Therefore, we recommend that you do
not modify System Manager data created by an export host job. System Manager warns you if you
attempt to modify System Manager data created by an export host job but does not stop you. If you
must build your own menus in System Manager that refer to exported data, we recommend that you
create new menus rather than modify exported ones. Avoid the menu prefix that you used in the
exports, for example, IDF, to prevent a conflict.

After you run the export host jobs, you must refresh the System i Workspace data.

See "Updating Workspace Application Manager in SiW” in this guide.

Exporting multiple environments

Environments are usually independent of each other in both IDF and System Manager. You can
export different IDF environments independently and with different options.

If a user in System Manager has the same initial menu identifier in all environments, then the
environments interact. That is, if a user’s initial menu is IDFUS00123 in one environment, then the
initial menu is IDFUS00123 in all other environments. In XA, the menu might or might not have the
same definition in all environments and the menu might not even exist in all environments.
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The Export public metadata to Workspace host job does not create user specific menus. The
default menu is IDF. The default menu can be changed; however, the menu length must always be 3
characters.

The Export private metadata to Workspace host job creates specific user menus that allow access
to the user’s private card files and cards. The names of these menus are the selected prefix,

IDF by default, followed by US and a number. The numbers are assigned sequentially, for example,
00001, 00002, 00003, in the first run of the host job. When the job is run for a second or later
environment or rerun for the first environment, any previously exported user is assigned the same
number. Users not previously exported are assigned a new number. Therefore, the user menu
numbers may not be consecutive on the second or subsequent export.

Problems can occur if private metadata is exported in one environment and not another since one
environment assigns an initial menu such as IDFUS00123 and the other environment, IDF.

To avoid problems with initial menus, we recommend these guidelines:

* If you export private metadata in one environment, do so in any other environments as well. If
necessary, re-export environments that were previously exported with only public data.

* Use the same menu prefix in all environments. We recommend that you use the default menu
prefix, IDF, unless a clash with existing menus occurs.

* If some users have an incorrect initial menu because you changed from public to private export
host jobs or changed the prefix, then run the Export public metadata to Workspace host job
again or the Export private metadata to Workspace host job with Set user attributes
specified as Yes.

If you are familiar with System Manager, you can use System Manager functions to specify or correct
user’s initial menus or authority. If you change user’s initial menus or authority in System Manager,
we recommend that you specify No for Set user attributes in the Export public metadata to
Workspace host job or the Export private metadata to Workspace host job.

Example of exporting multiple environments

Menus are defined in environments. For example, the menu SOMEMENU in environment AA is not
necessarily the same as the menu SOMEMENU in environment BB and the menu might not exist in
environment CC. However, the initial menu for a user does not specify an environment. So, if you
change the initial menu for SOMEUSER to SOMEMENU, then you need to ensure that SOMEMENU
exists in all the environments that SOMEUSER accesses. SOMEMENU is not required to be the
same in all the environments, but it must exist. Because of this requirement, you must either use the
Export public metadata to Workspace host job in all environments or Export private metadata to
Workspace host job in all environments.

For example:

* The Export public metadata to Workspace host job is run for environment AA. The menu IDF is
exported and specified as the initial menu for all users. At this point, all users must be able to
access SiW for environment AA and see the menu IDF.
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* The Export private metadata to Workspace host job is run for environment BB. User specific
menus such as IDFUS00123 are generated and specified as the users’ initial menus. For
example, user JOHNDOE has his initial menu specified as IDFUS00123. JOHNDOE can
successfully access SiW for environment BB and see his personal menu but gets an error when
he tries to access environment AA since there is no menu IDFUS00123 in environment AA.

If the two export host jobs had run in the reverse order, then the problem is different. If the Export
public metadata to Workspace host job is run second, the initial menu for JOHNDOE and other
users is changed to IDF. JOHNDOE can access SiW in both environments but only sees menu IDF.
He does not see his personal menu IDFUS00123 in environment BB.

This example assumes that the Default menu prefix has been used in all exports and that Set user
attributes is Yes. The result is different with other settings but in all cases problems happen. Your
only solution is to either use the public job for all environments or the private job for all environments.

The Export private metadata to Workspace host job ensures that the same menu name is used in all
environments. If JOHNDOE is assigned IDFUS00123 in environment AA, then he is assigned
IDFUS00123 in BB.

Note: Refer KB2105811 on Export Metadata log and Export L1 data log for further reference.

Updating Workspace Application Manager in SIW

After the completion of Export metadata, the users must update the Workspace Application manager
to update the definitions, exported from IDF to System Manager, in SiW.

1 Open the utility by specifying this URL for SiWA:

https://<hostname>:<port>/<web-contextname>/admin.html

2 Navigate to Update Definitions under Application Manager.

3 Choose the respective profile from the Choose Profile list.

4 If you are performing this process for the first time after environment setup or after metadata
export, then select Update main Application Manager definitions and click Update.

5 Click select all to select all users and roles or select a specific user.

6 Select the Update main Application Manager definitions check box to ensure all definition
updates in System Manager are reflected in System i Workspace.

7 Click Update.

Note: See “System i Workspace additional configuration” in the System i Workspace AnyWhere
Installation & Administration Guide.
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Chapter 6 Additional configuring in SiW

Additional configuration is required in SiW after you export your metadata.

Changlng System i properties

Locate the SiIWA WebSphere system.properties file as documented in the System i Workspace
AnyWhere Installation Guide.

2 Add this property to enable SiWA to launch from Infor LTR:

*  Property: com.infor.siw.cloud.mingle.url

« Description: The URL, minus any context path, of the Infor LTR server that is hosting SiWA.
This URL must be correct to prevent ClickJacking, or the browser will not let System i
Workspace execute inside Infor LTR. For example: https://mingle.your-enterprise.com

3 Restart System i Workspace. For an IBM i deployment, ensure the server1 application server
and HTTP server are also restarted.

Configuring Single Log Out
If using SIWA FP 14 or above, these settings are discontinued and will not be available for you.

To configure Single Log Out (SLO) in the System i Workspace, go to System i Workspace AnyWhere
Administration interface (admin.html) > Workspace Configuration > Profiles > Xi Platform
Integration settings > Single Log Out Behaviour.

This table shows the SLO options within the System i Workspace.

Infor XA Configuration Guide for Infor LTR using System i Workspace AnyWhere | 39


https://mingle.your-enterprise.com/
https://mingle.your-enterprise.com/

Setting Description

Allow and terminate all System i Emulator The Sign Out option inside the System i

sessions Workspace AnyWhere Application menu is
hidden. To sign out, the user must use the Infor
LTR Sign out option.

If the user signs out of Infor LTR while having
active 5250 AnyWhere Emulator sessions, the
sessions are disconnected from the client, but
preserved on the System i Workspace server.
The sessions are automatically recovered and
restored when the user next signs into System i
Workspace

If the user signs out of Ming.le while having
active System i Emulator sessions, the sessions
are terminated unless using the System i
Workspace Telnet Proxy, which can cause
object and record locks within your system.
Customers, that do not use the

System i Emulator, must use this setting.

Note: This option is the recommended setting for
customers who use the 5250 AnyWhere
Emulator for running the daily SIM tasks in the
enterprise.

Block if any active System i Emulator The Sign Out option inside the System i Workspace
AnyWhere application menu is displayed. Users must
manually exit any System i Emulator tasks, and then
sign out of System i Workspace before signing out of
Infor LTR. This is the default setting.

System i Workspace additional configuration

System i Workspace is configured during the installation process so, by default, no additional
configuration is needed to start and use System i Workspace.

However, you may want to add additional environments and additional profiles by referring to the
System i Workspace AnyWhere Installation & Administration Guide.
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Chapter 7 Configuring XA in Infor LTR

Use the steps provided in this section to configure XA with Infor LTR and using Ming.le.

As mentioned in “Post installation,” we recommend that you have one System i Workspace profile for
each XA environment that you intend to configure and to match each profile with one Infor LTR
application. For example, you can have an XA test environment and an XA production environment,
each with their own Application tab.

To configure the integration, log on to Infor LTR with a user ID that is assigned Administrator role for
the Infor LTR application.

You can use the Infor LTR environment to access the IDF views and screens. Users can access the
Net-Link windows to which their user profile has authorization. Users can view all the IDF options
that were exported whether the user profile has authority to the options.

Infor LTR uses Infor ION terminology. If you have installed Infor ION and configured ION to work with
XA, use the same values that you used in that installation. If you are configuring Infor LTR but have
not yet implemented Infor ION, note the values that you use and then use these same values when
you install Infor ION.

These terms are common to Infor LTR, Infor ION, and integrations that use Infor ION:

* Tenant.
The tenant is the container for accounting entities and locations. No data is ever shared or
accessible between two tenants. Your production environment and your test environments are
separate tenants. The default tenant is Infor.

* Accounting entity
The accounting entity is the lowest level for financial reporting. In an XA implementation, a
Financial Divisions, Companies, Sites, and Warehouses are accounting entities. Accounting
entities are defined as an organization node in the Financial Division, Company, Site, and
Warehouse Obijects.

* Location
Location is a geographic site of an organizational facility or function associated with a user,
typically a warehouse or an office.

* Logical ID (lid)
The logical ID is the identifier used to locate the environment. The ID is generated based upon
the hostname and environment and takes the form lid://infor.xa.{mysystemi}-{xy}.

mysystemi is the System i name in lower case and xy is the environment code also in lower
case. .
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You can configure XA as an application in Infor LTR by using Admin Settings option under
“User Menu” on top-right corner. After configuring XA in Infor LTR, users can view XA as an
application in App Menu, similar to other Infor applications such as CRM and EAM. User can
launch XA by clicking on the XA specific option in App Menu.

Adding the XA application in Infor LTR

1 Login to Infor LTR using the account setup for IFS administration.
2 Click the User Menu option in the top right-hand corner and select Admin Settings.

3 Click the + Add Application option.

Admin Settings
Manage Applications Manage Context / Utility Apps Manage Drillbacks General Settings

Manage Applications + ADD APPLICATION

4 Select Infor Application

Admin Settings
Manage Applications Manage Context / Utility Apps Manage Drillbacks General Settings

Add New Application

Application Type *
© Infor Application

Non-Infor Application

5 Specify this information to create the XA application option:

Application Name

Select XA 9.1 or XA 9.2 application from the list.
Display Name

Specify a display name for this application.
Application Icon

Select an icon for the application.
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Logical ID

Specify in the XA environment, which is appended to the logical make-up, the logical ID. For
example, lid://infor.xa.<environment>. Use HTTPS

Ensure that this setting is enabled to use HTTPS.

Host Name

Specify the fully qualified host name of your System i Workspace server.

Port

Specify the port number used by System i Workspace. By default, this field is set to 443.
Context

Specify the web context name that was defined for the System i Workspace. By default, this field
is setto systemi.

Default Tenant

Specify the profile name defined within System i Workspace. We recommend that this field is set
tothe XA Profile ID, which is case sensitive.

Navigation Method

Select the navigation method as Same Screen and Click on Save.

Admin Settings
Manage Applications Manage Gontesxd / Utility Apps Manage Drillbacks General Settings

Application Details
Application Name and Version

Display Name *

| L2M-AA(Tomeat)

Change lcon

Deployment Information Permissions Context/Utility Apps Custom Parameters Logical ID Fallback

Use HTTPS

Host Mame *

| usalvanecaion 12 infor com |

Port

| 6443 |

Context

| systemil 2MAA |

Default Tenant ID

| default |

Logical ID *

| lid:ffinforxa.usalil2m-aa |

Mavigation Method

| Same Screen - |

Caneel m
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6 Select the Permissions tab.
7 Click Add New Users and/or IFS Security Roles.

8 Referto the “Create a new application security role”, as displayed, to create a new security role
specific to XA. Search and select the role created

Display Name *
‘ L2M-AA(Tomcat)

Change Icon

Deployment Information Permissions Context/Utility Apps Custom Parameters Logical 1D Fallback

Delete  Add New Users andior IFS Security Roles

Name Role Logical ID
* Infor-SystemAdministrator IFSSecurityRole lid:/finfor.social.instance01
& MingleAdministrator IFSSecurityRole lid:/finfor.social.instance01,lid://infor.social .1
] A XA-Administrator IFSSecurityRole lid:/finfor.social.instance01, lid://infor.xa.usalil2m-aa
M & XA-User IFSSecurityRole lid:/finfor.social.instance01, lid://infor.xa.usalil2m-aa

11. Click Done
12 Click Save.

13 Click OK.

14 .Click Cancel to exist

Create a new application security role

1 Log into Infor LTR using the account setup for IFS administration.

2 Click on the User Menu option in the top-right corner and select User Management.
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0 JanyKhan Patan

Admin Settings

User Settings

User Management
Social Data

Apps & Authonzations
Help

About

Sign out

3 On the Application menu, select Configure > Master Data Types > Security Roles.

Masiof Dota Types /  Securty Row
+ 3
Namo Description Assign 10 New Usors

=] AltributeServiceCaller This s an IFS (ole that alows the user 1o call the IFS Alribute No

=) DataAdménstrator This 5 an IFS 1ol that aows the user 10 aominster master

[‘; DECISIONSERWICE - Users who can appeove and activale or reject an approval No

m DECISIONSERVICE- Users who can create, update and subimi an approval matnx n No

™ GRIDAPP- The users wih this role has Access 10 Activity Locator context No

| e | fe=1la) 1 Jagnie ybth G sein pont B o Siriiniairatne St gt I The CSo N N

4 Click the + option to add a new security role.
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&~ Security Role

B &

Name *

Description ™

XA-SIWA access role

Assign to New Users

5 Specify a name and security role for the Description.

6 Select the Assign to New Users check box so that, in future, any new users that you add to
Infor LTR can automatically get access to this new security role.

7 Click the + option to add users to the security role. If you have not yet added any users, then
refer to “Adding users” for adding users into Infor LTR.

Assign Users to Security Roles -+ ADD -+ ADORCLOSE X
| Search for Users janykhan Q
v User ID Name Emaul Address
INFOR\patan1 JanyKhan Patan JanyKhan Patan@infor com

8 Specify the username you want to add to the security role in the Search for Users prompt, as
displayed in the screen shot, and then click the magnifying glass option.

9 Select the user to add from the table and click Add.

10 Repeat the search to include each user, and then click Add & Close to return to the main
interface.
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STt

XA-SIWA access role

Assign 10 New Users

INFORYjpatan1

| INFOR\apurnam
INFOR\adiwit
INFOR\AEKinci

INFOR\asingh10

Users Documents Identity Repository Groups SCIM Groups

Applications

JanyKhan Patan

Abhinav Pumam

Akash Dixit

Ali Ekinci

Amit Kumar Singh

The table is updated with the selected user profiles.

11 Click the Save Item option to apply the users to the security role.
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Local Network Access

When users access Infor LTR in Google Chrome or Microsoft Edge web browsers, ensure that a
solution is in place for the Local Network Access restrictions implemented by these browsers. The
web browser restrictions, which are intended to protect the local network, may prevent access to
System i Workspace Anywhere from Infor LTR.

Please read KB3645324 Users Are Unable to Access Infor Applications after upgrading to Chrome
version 142 and Edge 143 (or later) for full details and solutions.

Launch XA in Infor LTR

Go to App Menu and click the XA application option.

:EE Homepages

~
‘.‘
~

Homepages LN 10.7 Infor Ming le™

Infor ION API ION Desk

e [1]
En

LN 107 L2M-
AA(Tomcat)

The XA application is launched with menu and other details to access.
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25 eucelvwsunsup47.infor.com/infor/1

03 infor Campus Extrm.. [ 1aM [ v

System i Home

Infor XA 10.0 - (1)

My Favorites - 0B My Tasks a
® A Bills of Material = [ IDF =
@ Kl tem Revisions ‘v".' SR Default |
® Item Processes - Customer Relationships
® Kl Customer Orders and Quotes & [DEEIE Customer Service
® B System-Link Destinations - Engineering
® H System-Link Requests = Materials
@ hitps://usalvwwxaion12.infor.com:6443/sy - Production
® Purchase Orders - Finance

& [EIEEIE Procurement
& RS Planning
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Chapter 8 Single Sign-On within Infor LTR

SiWA is the user interface for Infor XA. If you intend to use SiWA with Infor LTR. This chapter describes
the steps to enable the Single Sign-On (SSO) functionality to launch SiWA from within Infor LTR using
ADFS or STS.

Note: SiWA should be running on FP 13, at least, and latest Infor LTR for SSO with Infor LTR to work
without any issues.

This chapter covers SSO enablement for these combinations:

+  SiWA with Windows deployment (Tomcat) on Infor LTR using Kerberos SSO.

+  SiWA with Windows deployment (Tomcat) on Infor LTR using SAML SSO.

+  SiWA with IBMi deployment (WebSphere) on Infor LTR using Kerberos SSO.

+  SiWA with IBMi deployment (WebSphere) on Infor LTR using SAML SSO.

If users are going to be using SSO for both SiWA and a 3rd Party 5250 Emulator such as IBM Access
for I, then we recommend that each IBMi user has its Set password to expired set field set to NO
and the User password set to a random GUID password which cannot be guessed.

Note: If IBMi users have their Set password to expired set to *YES, this causes the Change Password
window to appear during a SSO if the user’s password has expired.

Kerberos SSO

To implement Kerberos SSO, refer to the process described in the “Enabling SSO with Microsoft
AD and IBMi EIM” section of the System i Workspace AnyWhere Installation & Administration
Guide.

Security Assertion Markup Language SSO
Implementation

Use these steps for Infor LTR implementation.
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Obtaining the setup zip file
To obtain the setup zip file, download the InforOS_SSO_Setup zip file from the SiWA solution KB1963350
in Infor Concierge.

This file must be extracted or copied to the root directory of a Microsoft Windows PC or Server that has
Amazon Corretto Java 8 installed and has the JAVA_HOME environment variable and PATH variable
correctly configured to point to a valid Amazon Corretto Java 8 executable.

Updating the service provider metadata
1 Copy the file sp_XA.properties to sp.properties.

2 Update the following properties within the sp.properties file.

Property Description

sp.entityid Replace TENANT with the environment code being used within
SiWA: ERP_XA_TENANT

sp.common.name Replace siwa-hostname.domain.com with the hosthame and
domain of the SiWA server.

sp.sso.url Replace server-name.domain.com with the hostname and
domain of your SiWA server: https://siwa-
hostname.domain.com:443/systemi/CloudintegrationServiet

sp.slo.url Replace server-name.domain.com with the hostname and
domain of your SiWA server:
https://siwahostname.domain.com:443/systemi/fedletSIoPOST

sp.fedletadapter.class Specify com.geac.xtrane.servlet.http.CloudSLOFedletAdapter.

3 To continue implementing your SAML SSO, see the next set of task steps for the Infor LTR you are
using:

* Infor LTR ADFS: “Creating the Infor LTR ADFS identity provider and fedlet metadata”

* Infor LTR STS: “Creating the Infor LTR STS identity provider and fedlet metadata”
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Creating the Infor LTR ADFS identity provider and fedlet metadata
1 Copy the file idp_ADFS.properties to idp.properties.

2 Launch this URL from any browser, replacing adfs-server-name.domain.com with the hostname and
domain of your ADFS server:

https://adfs-server-name.domain.com/federationmetadata/2007-06/federationmetadata.xml You are

asked to download the FederationMetadata.xml file.

3 Open this file in Microsoft Windows Notepad and locate the Signing Certificate, which can be found
under the element <KeyDescriptor use="signing”> and between these elements
<X509Certificate>Signing Certificate</X509Cerlificate>.

4 Copy the signing certificate without the elements.

5 Update these properties within the idp.properties file:

Property Description

idp.adfs.entityid Replace adfs-server-name.domain.com with the hostname and domain of
your ADFS server:

http://adfs-server-
name.domain.com/adfs/services/trust

idp.adfs.location Replace adfs-server-name.domain.com with the hostname and domain of
your ADFS server:

https://adfs-servername.domain.com/adfs/Is/

idp.adfs.certificate Paste in the IDP Signing Certificate that you copied.

6 Run the build-metadata.bat command with the following parameters: build-metadata.bat /OP /ADFS
sp.properties idp.properties.

This command creates a populated set of fedlet metadata in the fedlet_config folder.

7 Go to Copying the fedlet metadata folder.
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Creating the Infor LTR STS identity provider and fedlet metadata

1 Copy the file idp_STS.properties to idp.properties.

2 From any browser launch this URL, replacing sts-hostname.domain.com with the hostname and
domain of your InforSTS server:

https://sts-
hostname.domain.com:9553/inforsts/rest/metadata/00000000000000000000000000000000/wsf

ed/idp
You are asked to download the sts-metadata-idp-wsfed.xml file.

3 Open this file in Microsoft Windows Notepad and locate the Signing Certificate, which can be found
under the element <KeyDescriptor use="signing”>, and between these elements
<X509Certificate>Signing Certificate</X509Certificate>.

4 Copy the signing certificate without the elements.

5 Update these properties within the idp.properties file:

Property Description

idp.sts.entityid |[Replace sts-hostname.domain.com with the host name and domain of your InforSTS server:
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000

idp.sts.sso Replace sts-hostname.domain.com with the host name and domain of your InforSTS server:

https://sts-
hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samISS O

idp.sts.slo Replace sts-hostname.domain.com with the host name and domain of your InforSTS server:

https://sts-
hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samISLO

idp.sts.certificatePast the IDP Signing Certificate you copied.

6 Run the build-metadata.bat command with these parameters: build-metadata.bat /OP /STS
sp.properties idp.properties.

This command creates a populated set of fedlet metadata in the fedlet_config folder.
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7 Continue with “Copying the fedlet metadata folder” section.

Copying the fedlet metadata folder

Copy the fedlet_config folder to the root folder of your SiWA server. For an IBM i deployment of SiWA,
this folder will most likely be the ROOT folder of the IFS.

Note: For IBMi deployments, after copying the fedlet_config folder to the IFS, check that the encoding
of the idp.xml file is in ANSI format. We have observed instances where this file is created in UTF-8
format, which seems to cause issues with the OpenAM API. If the idp.xml file is in UTF-8 format, then
the lead bytes are not converted correctly during the copy to the IBM i IFS. If the format is UTF-8,
then open in Microsoft Windows Notepad and use Save As to change the encoding to ANSI. Do not
change the idp.xml file name.

Java runtime changes

After copying the fedlet metadata folder, you need to add an additional Java runtime property for SiWA
to identify the location of the fedlet metadata folder:

-Dcom.sun.identity.fedlet.home=<Path to fedlet metadata folder>

For Windows SiW deployment, see “Adding Java runtime properties to Windows SiW deployment.”

For IBMi SiW deployment, see “Adding Java runtime properties to IBMi deployment.”

Adding Java runtime properties to Windows SiW deployment

Using RegEdit, update this registry key to add in the additional -D parameter:

HKEY LOCAL MACHINE\SOFTWARE\WOW6432Node\Apache Software Foundation\Procrun
2.0\SiWAnyWhere\Parameters\Java\Options
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File Edit View Favorites Help

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW®6432Node\Apache Software Foundation\Procrun 2.0\SiWAnyWhereL2MAA\Parameters\Java
> Setup A || Name Type Data
> Softwin ab] (Default) REG_SZ (value not set)
2 w""x"' ":' 8] Classpath REG_SZ EASIWA_L2MAA\tomcat\bin\bootstrap,jarEASIW...
4 45 oApi::ZQ S:?t:vure Foundat Edit Multi-String X REG_SZ C:\Program Files\Amazon Corretto\jdk17.0.11_9\bi...
REG_DWORD 0x00000080 (128)
& v Procrun 2.0
o 4 SiWAnyWhereDP11 Value name: REG_DWORD 0x00000800 (2048)
N SiWAnyWhereDP12 IOpuom REG_MULTI_SZ -Dcatalina.home=E:\SIWA_L2MAA\tomcat -Dcatal...
N SiWAnyWherel02 | Value data: REG_MULTI_SZ --add-opens=java.base/java.lang=ALL-UNNAMED...
> || SiWAnyWherel2CD |.Dcatalina home=E:\SIWA_L2MAA\tomcat
v SiWAnyWherel2MA -Dcatalina base=E:\SIWA_L2MAA\tomcat
h  endorsed dirs=E:\SIWA_L2MAA\tomcat \endorsed
V. i Parsmetess -Diavaio tmpdir=E:\SIWA_L2MAA\tomcat \temp
. Java -Djava util logging manager=org apache juli ClassLoaderLogManz
Start [ o : =
Stop
o > SiWAnyWherelL2M(
d > SiWAnyWhereTST
; > BigFix < >
> Classes
nf > Clients S
> CrowdStrike
> Google
> Infor
InforlT
> Intel
. > Microsoft
h Notepad++
> 0DBC
N Daliriac

Adding Java runtime properties to IBMi deployment

1 Use the IBM WebSphere Administrative Console to make configuration changes. From the menus,
select Servers > Server Types > WebSphere Application Servers.

& - C O A Notsecure | usalil2m.infor.com:9060/ibm/console/login.do

Change your Infor... n Jira Integrations fav. @ webmail ﬂ Infor Support Portal...
WebSphere.
Cell=usalil2m, Profile=default
’ View: [All tasks v] |
= Welcome

[+ Guided Activities Application servers

Use this page to view a list of the application servers in your environment and the status of each of these servers. You ca

=l Servers to change the status of a specific application server.
[= Server Types & Preferences
= WebSphere application servers —
Sp pp e Ig!
= WebSphere MQ servers e
= Web servers z
Name & Node Host Name { Version {

[+ Applications You can administer the following resources:
Services WSAnyWhere usalil2m usalil2m.infor.com Base 9.0.5.4
(4] Resources serverl usalil2m usalil2m.infor.com Base 9.0.5.4
Security Total 2
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installation.

Process Management option.

Configuration

General Properties

Name
lWSAnyWhere ‘

Node name

‘usalllzm ‘

@] Run in development mode
Parallel start

O start components as needed
Access to internal server classes

Allow Vv

Server-specific Application Settings

Classloader policy

Class loading mode
Classes loaded with parent class loader first v

Apply || OK || Reset || Cancel |

4 Select Process definition.

Server Infrastructure

Clzss loader

Process definition

Process execution
@ Administration

Java SDKs

Select your System i Workspace AnyWhere Application server, usually WSAnyWhere for a default

On the Configuration window, under the Server Infrastructure section, expand the Java and

Container Settings

Session management

] SIP Container Settings

o+

# Web Container Settings
@ Portlet Container Settings
@# EJIB Container Settings

# Container Services

[# Business Process Services

Applications

Installed applications

Server messaging

Messaging_engines

Messaging_engine inbound transports

WebSphere MQ link inbound transports

SIB service

Server Infrastructure

# Java and Process Management

# Administration

5 Under the Additional Properties, selessct Java Virtual Machine.
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Application servers

Application servers > WSAnyWhere > Process definition

Use this page to configure a process definition. A process definition defines the command line information necessary to start or initialize a process.
Configuration

General Properties

Additional Properties
Executable name

Java Virtual
Machine
Executable arguments

Environment
Entries

Process execution

Process Logs

Logging and tracing
Start command

6 Locate the Generic JVM arguments field towards the bottom of the window. This field may have
existing values.

Initial heap size

1024 MB
Maximum heap size

4096 MB

[:] Run HProf

HProf Arguments

) Debug Mode

Debug arguments

|—agentlib :jdwp=transport=dt_socket,server=y,suspend=n,address=7777
Generic JVM arguments

-Djava.awt.headless=false -Dclient.encoding.override=UTF-8 -
Dcom.ibm.xml.xIxp.jaxb.opti.level=3"-

Executable JAR file name

(J Dpisable 317

7 Atthe end of the existing arguments, add a space followed by the path to your fedlet_config folder:

Generic JVM arguments

-Djava.awt.headless=false -Dclient.encoding.override=UTF-8 -
Dcom.ibm.xml.xIxp.jaxb.opti.level=3 -
Beomsin dentity fedlcthome=/s

SO_PP/fedlet config

/|

8 After this setting, add these space-separated additional arguments to configure the OpenAM classes to
use the IBMJCE for certificate decryption:

-DamCryptoDescriptor.provider=IBMJCE
-DamKeyGenDescriptor.provider=IBMJCE
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Generic JVM arguments

-Djava.awt.headless=false -Dclient.encoding.override=UTF-8 -
Dcom.ibm.xml.xIxp.jaxb.opti.level=3 -
Dcom.sun.identity.fedlet.home=/SSO_PP/fedlet_config -
DamCryptoDescriptor.provider=IBMJCE -
DamKeyGenDescriptor.provider=1BMICE 4

9 Click Apply and Save.

Changing system properties

1 Locate the System i Workspace AnyWhere WebSphere system.properties file as documented in the
System i Workspace AnyWhere Installation Guide.

2 Add these properties:

Property

Description

com.infor.siw.cloud

Set to 1 to enable SSO

com.infor.siw.cloud.idp.properties

Specify the path to the SAML metadata folder used by SiWA to extract
values from the metadata needed at runtime such as the

Epoch Cookie name and domain.

Example for SiWA Windows deployment:

com. infor.siw.cloud. idp.properties=C:/fedlet config
Example for SiWA IBMi deployment:
com.infor.siw.cloud.idp.properties=/fedlet config

com.infor.siw.cloud.mingle.url

The URL, minus any context path, of the Infor LTR server that is hosting
SiWA. This is used to prevent ClickJacking so the URL must be correct,
or the browser will not let SIWA execute inside Infor LTR. For example:

com.infor.siw.cloud.mingle.url=https://I0OS-hostname.domain.com

com.infor.siw.cloud.mingle.slo.url

The URL, minus any context path, from either the idp.adfs.location,
idp.sts.slo or idp.saml.slo.url property value from the file idp.properties.
This is used to prevent ClickJacking so it must be correct, or the browser
will not let SiWA log out correctly from Infor LTR, For example:

com.infor.siw.cloud.mingle.slo.url=https.//slo-hostname.domain.com

3 Save the changes. SiWA can now be restarted.
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Note: For an IBM i deployment, ensure the server1 application server and HTTP server are also restarted.

You can now only access pages within SiWA after signing into the Infor LTR platform. Direct access
is now disabled.

Updating Infor LTR Manager application

1 Log into the Infor LTR Manager from your Infor LTR server as displayed and click Continue.

Infor LTR Manager
Database Server : EUCE1WSUPPDBO9.infor.com
Database Instance :
Database Type: SQL Server v
Port: 1433
Authentication Mode : SQL Server Authentication v
User Login : sa
Password : v
Infor LTR Farm : Infor_LTR202312FARN_Farm .
Continue Cancel

2 Click Applications and locate the XA application.
3 Double-click the XA application.
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Infor LTR Manager (LTR202312FARN) - -] x

“) | Infor LTR (LTR202312FARN - -
o 1)
g
[ s
a Bootstrap Applications
@
g Registry Name Description | Relying Pa... SSO Ur Applicatio... SLO Url  |SSO Applic..., Download =
o
B Machines » COLLABORA.. COLLABORA.. COLLABORA...
Clusters COMPANION COMPANION COMPANION
Application Containers DATALAKE DATALAKE DATALAKE
Database Instances DECISIONSE... DECISIONSE... DECISIONSE...
Applications Grid-XiPlatfo... Grid SAML S... um:infor_LTR... https://euce... GRID https://euce... ¥,
System Configurations HOMEPAGES HOMEPAGES HOMEPAGES
Tenant Configurations IDM IDM IDM
Services IFS Infor Federat... IFS
Certificate INBOX INBOX INBOX
CloudSuite INFORSTS SP Connecti... urn:infor_LTR... https://euce... INFORSTS &
Advanced Features ION ION ION .

4 Relying Partner Identifier
Specify the value that matches the value of the property sp.entityid from the sp.properties file.
SSO URL
Specify the value that matches the value of the property sp.sso.url from the sp.properties file.
SLO URL

Specify the value that matches the value of the property sp.slo.url from the sp.properties file.
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Application .

Application Name : XA

Description : XA-L2M-AA

Application Type : XA( ERP Discrete iEnterprise (XA) ) v
SSO Application : INFORSTS v

Relying Party Identifier: ERP_XA_AA

SSO Url : https://usalvwwxaion12.infor.com:6443/systemilL.2MAA/Clouc
SLO Url : https://usalvwwxaion12.infor.com:6443/systemiL.2MAA/fedle’
Signing Certificate : C\Users\vkaja1\Desktop\SiW_Certificatel.cer

Save

5 Click the button for the Signing Certificate field to select the certificate SiW_Certificate1.cer found in
the root of the fedlet_config folder.

6 Click Open.

7 Click Save.

To continue implementing your SAML SSO, see the next set of task steps for the Infor LTR you are
using:

» Infor LTR ADFS: See “Updating the Infor LTR ADFS server through the ps1 file.”
* Infor LTR STS: See “Updating the Infor LTR STS.”

Updating the Infor LTR ADFS server through the ps1 file

1 Click the Download option for the XA application.
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XA-L2A-FF XA-L2A-FF ERP_XA_FF https://usalv... XA https://usalv... XA-L2A-FF 3

2 Specify a download path or use the Search button to find the path.

Download Path

C\
Identity Provider: ysalvwxadvsglO1.infor.com -

Download Cancel

3 Click Download.
& Infor_OS_L1619608944_XA-L2A-FF_ADFS_IFS_Add_RP

4 Copy the .ps1 file to the root of your ADFS server.
5 Log on to the ADFS server.

6 Open the Windows PowerShell as an Administrator.

7 Runthe command Set-ExecutionPolicy Unrestricted and confirm the execution policy by
typing Y and pressing Enter, if required to do so.

PS C:\Windows\system32> Set-ExecutionPolicy Unrestricted

Execution Policy Change

he execution policy helps protect you from scripts that you do not
trust. Changing the execution policy might expose you to the security
risks described in the about_gxecution_Policies help topic at
http://go.microsoft.com/fwlink/?LinkID=135170. Do you want to change the
execution policy?

[Y] Yes [Ng No [S] suspend [?] Help (default is "Y"): _

te the .ps1 file downloaded in above steps and then run as displayed.

16 8944 XA-L2A-FF_ADFS_IFS_Add_RP.psi

IsPublic IsSerial Name

True s SwitchParameter System.Vale ype
True L€ SwitchParameter ys alueType
Trus False System.ValueType

.ValueType

Creating for Infor_XA-L2A- 0S_L15619688944
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9 Launch the ADFS Management console.

10 Select Trust Relationships > Relying Party Trusts and locate your application.

11 Note the reference ID of your application. For example, OS_L1619608944.

12 Right-click your application and select Edit Claim Issuance Policy.

E T

L ADFS

Serace

o Access Control Pelicies
_ Rabong Party Tnats

1 Clawns Provider Trasts
L Applcstien Groupt

Q9 Fie Action View Window Meip
s nm Bm

Rehpiong Party Trunts

Cragiey Nare

Irfor_Gnd Xl O5_L1619600%88
o _INFORSTS _OS_LI61S60e0e
o XGPORTAL O35 _L1619600%4¢
ior_Bssen Vot 05 11619608904
"

hor_XA_O5_L161508548

o XALIMER OS5 _L1519600%44
o JALIMEG 05 L16150ese
o XALIC 54 OF _L1619600%
o _XALICSE_O5_LIS1960a0e
e XALODD 05 LI615608544

Updats fraem fedenstion Metadata

de Access Control Policy...
£ Claiem Insuance Polkcy..

Ovable
Properties
Detete

Help

un e 05 _L1615600584 Ged NP
um for_05_L1619600%8L rdormy
wm rfer_05_L1619608564 ponal
g / Anshvenaden g0t rioe com 30
reps / Aaaiveinai0t 022 200 iofe
ERP_XA_EG

BRP_XA_EE

ERP XA _LIMEG

EAP XA LXCSE

ERP_XA_LXCS%

ERP_XA DO

H e

pdate romm beder it
Eda Accent Control Pobi.
£d0 Clawn lnswance Pob
Ovable

K Delete
H ree

13 Click Add Rule.

lsm'frardwn%[ml* NQII“- Auth

The following transform nies specify the claims that will be sent to the relying patty.
Order Rule Name issued Claims
1 INFOR-GENERATED: Emtt Customar <See clam rule>
2 INFOR-GENERATED: Emt Identty (stp ... <See claim rue>
3 INFOR-GENERATED: Emt Identty2 {co <See clam nie>
B INFOR-GENERATED: Emtt IFSUserlook... <See clam nie>
5 INFORGENERATED: Emt OlentPrincp...  <See claim rule>
6 INFOR-GENERATED: Emi IFS Person | <See clam nie>
7 Emt Environment Type <See claim rule>
8 Custom nde for intemal Transient 1D <See claim nie>
S Custom nde to emt a transient NamelD <See clam nie>
10 Emi temporary 10s for customer and tenart  <See claim rule>
n Emg temporary 103 for user <See claim nie>
2 Eme Customer claim Customer
13 Emk Tenart claim <See cloim nde>
14 Pass Through identty claim dentty
15 Pass Through Identty2 clam Identity2
16 Pass Through Clert Princpal cloim Cert Prncipal Name
17 Em IFS Authertication Mode <See claim nde>

| AddRue. | | EdtRue_ | | Remove Rue.. |

14 Select the Send Claims Using a Custom Rule option from the list.
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@

Select Rule Template

Steps
@ Choose Rule Type
@ Configure Cam Rute

VServ!Owslega':»st v

Add Transform Claim Rule Wizard x|

Select the template for the claim rue that you want to create from the following ist. The descrption provides
detnis sbout each cam nue template

Clam nie template

Cam rule template description

Using 3 custom nie, you can creste nies that can't be creasted with 8 nie template. Custom nies se
writen in the AD FS clam nde language. Capabilties that require custom nies include.

* Sending clams from a SQL attibute store

* Sending claims from an LDAP attrbute store using a custom LDAP filter

* Sending claims from 2 custom attribute store

* Sanding claims only when 2 or more ncoming claims are present

+ Sending claims only when an incoming claim value matches a complex pattem
+ Sending clasms with complex changes to an incoming clam value

* Creating claims for use only in kater nies

15 Click Next.

16 Specify Emit ERP Person ID claim for the Claim rule name.

17 Add this information into the Custom rule field. Change the reference ID to the reference ID of your
application, which you made a note of earlier from Relying Party Trusts on the ADFS console:

c1:[Type == "http.//schemas.infor.com/claims/userid"]=> issue(store =
"Infor_OS_L1619608944_InforFS data store”, types =
("http://schemas.infor.com/claims/ErpPersonld”), query = "WITH XMLNAMESPACES
(‘http://schemas.infor.com/claimvalues’ as ins) select Xml=(select BOD.PersonlD as

'ins:PersoniD', BOD.AccountingEntity as ‘ins:AccountingEntity', BOD.Lid as ‘ins:Logicalld’ for xml
path(‘ins:ErpPerson’),elements) FROM dbo.Users USR JOIN dbo.Properties P on USR.Id =
P.Userld JOIN dbo.PropertyTypes PT on P.PropertyTypeld = PT.Id JOIN dbo.PersonBODs BOD on
BOD.DistinguishedName = P.Value where PT.Name = 'UPN'AND USR.Id = {0}", param = c1.Value);
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[\ Add Transform Claim Rule Waard

Configure Rule
Steps You can & custom claim nde, such as a rnde that requires multiple incoming claims or that extracts
@ Ohoose Rude Type claims from & SQL attvbete store. To configure 8 custom nie. type one or more optional condtions and an
Bsuance statement using the AD FS clam nie language
@ Configure Oaim Rule
Clam nde name
[Emt ERP Person 1D

Rule template: Send Clams Using a Custom Rule
Custom nide

cl:[Type == “http://schemas.infor.com/claims/userid™]e> issue(store =
“Infor_05_ L1€19608544_InforFS data store®, types =

(“hetp://achemas. infor.com/claime/ErpPersonld®), query = “WITH
XMUGMESPACES (*hecp:i//achemas.infor.com/claimvalues’ as ins) select
Xmle(select BOD.PersonlD as 'ins:PersonlD’, BOD.AccountingEntity as
‘ins:AccountingEnticy’, 200.Lid as ‘ins:logicalld' for xml path
(‘ins:ErpPeracn'),elements) FROM dbo.Users USR JOIN dbo.Properties P on
USR.Id = P.UserId JOIN dbo.Propertylypes PT on P.Properctylypeld = PT.Id
{JOIN dbo.PersonBODs BOD on BOD.Distinguishedliame = P.Value where
PT.Mame = 'URN' AND USR.Id = {0)®, param = cl.Value):

el

18 ClickFinish
19 Click Ok.

20 Right-click your application and select Edit Access Control Policy.
21 Click the Issuance Authorization Rules tab.

22 Click Add Rule.
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B>

|| | lssuance Transform Rules | [ssuance Authoazation Fudes | Delegation Authodzation Rules |

The following authonzation nides specy the users that will be permitied access 1o the rehying
party. YWhen the kst does not contain a nie, all users wil ba denied access.

Order  Rule Name lssuad Clams

1 INFORGENERATED: Em2 Customer <See clam nde>
2 INFORGENERATED: Emt identity (strp ...  <See clam nje>
3 INFORGENERATED: Emt identty2 {co...  <See clam nide>
B INFORGENERATED: Eme IFSUserlook ..  <See clam nie>
5 INFORGENERATED: Emt QentPrincip.,  <See clam nie>
6
7
g

Em2 Environmert Type <See clam nia>
INFORGENERATED: Pass Through E- E-Mal Address
INFORGENERATED: Pass Through Giv... Given Name EI
9 INFORGENERATED: Pass Through Sur..  Sumame
10 INFOR-GENERATED: Pass Through Us.,  UserProfie Picture 1 ‘ i

n INFORGENERATED: Pass Through inf..  Comeuntyidentfier
12 Eme temparary 1Ds for customer and tenart  <See clam nde>

3 Deny users of disabled customer <See clam nie>
14 Eme temporary |Ds for user <See clam nie>
15 Em2 temporary Tenant Applcation <See clam nde>

16 Permt for TenantUsers and TenartAppl..  <See clam nie>

[AddRue_ | [ ExRe_ | [ Romove e |

L_OK || Concd || oo |

23 Select the Permit All Users option from the list.

Select the template for the claen nude that you want 10 craate from the following let. The description provides
detals about each clam nie template.

Clasm rue tomplate:
{Pomt 48 Users vl

Ciaim nje template descrption

Usng the Pormit Al Users nie tomplate you can pomt all users access 10 the relying party, You can use
addtional nies 1o futher restict sccess. Users who are pemmitied 10 8ccess the relying party from the
fodontion service may sl be denied service by the relying paty.
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24 Click Next.
25 Click Finish.
26 Click OK.

Updating the Infor LTR STS

1 Launch the STS Admin Ul from your Infor LTR server.

= STS Panel

Q Tenantid *

2 Click on SP connections.

3 Click the Import from File icon.

= S »r Connections

import from File

c+8©

4 Select the file sp.xml found in the root of the fedlet_config folder and then click Ok.
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Import from File
Select metadata file

sp.xmi X

Cancel Ok

5 Specify a unique value for the Display Name.

6 Ensure that Partner Entity ID is sp.entityid from SP properties.

= Service Provider Connections

c + 9 ®
Grid-XiPlatform / -
umnInfor_LTR202312FARN_N17050768 16:Grid_XiPlatform - o
INFORSTS / El.
urn:infor_LTR202312FARN_N1705076816:inforsts Y
XA 0o
o

ERP_XA_AA 2

7 Select Xa for the IFS application type.
8 Click the Save icon, and then click the Back icon.

9 Proceed with “Configuring ERP Person IDs in Infor LTR for SSO” section.

10 Start the SiWA service and validate the SSO functionality.

Migration from ADFS to Infor STS as Identity Provider

Infor XA Configuration Guide for Infor LTR using System i Workspace AnyWhere | 69




To use Infor STS as Identity provider in place of ADFS, see “Appendix K:Upgrading Infor LTR with Infor
STS as identity provider” in the Infor Local Technology Runtime Installation Guide for information on

upgrade your existing Infor LTR.
Follow these steps when ADFS is already configured and used as Identity Provider for SSO.

1 Stop the SiWA service if running.

2 Go to SiWA installation folder and take a backup of existing fedlet_config folder used for SSO.
3 Delete the fedlet_config folder from the root location.

4 Reusing existing InforOS_SSO_Setup folder for generating fedlet_config for ADFS.

5 Goto InforOS_SSO_Setup folder, open and delete the existing fedlet_config folder.

6  Copy the file idp_STS.properties to idp.properties.

7 From any browser launch the following URL, replacing sts-hostname.domain.com with the hostname

and domain of your InforSTS server:

https://sts-
hostname.domain.com:9553/inforsts/rest/metadata/0000000000000000000000000000000

0/wsfed/idp

8 Download the file sts-metadata-idp-wsfed.xml.

9 Open this file in Microsoft Windows Notepad and locate the Signing Certificate, which can be found
under the element <KeyDescriptor use="signing”> and between these elements
<X509Certificate>Signing Certificate</X509Certificate>.

10 Copy the Signing Certificate without the elements. You will use this certificate in the next step.

11 Update the following properties within the idp.properties file:
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https://sts-hostname.domain.com:9553/inforsts/rest/metadata/00000000000000000000000000000000/wsfed/idp
https://sts-hostname.domain.com:9553/inforsts/rest/metadata/00000000000000000000000000000000/wsfed/idp
https://sts-hostname.domain.com:9553/inforsts/rest/metadata/00000000000000000000000000000000/wsfed/idp

Property Description

idp

.sts.entityid |Replace sts-hostname.domain.com with the host name and domain of your

InforSTS server:

https://sts-
hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000

idp

.sts.sso Replace sts-hostname.domain.com with the host name and domain of your

InforSTS server:

https://sts-
hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/
idp/samISSO

idp

.sts.slo Replace sts-hostname.domain.com with the host name and domain of your

InforSTS server:

https://sts-
hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/
idp/samISLO

idp
ate

.sts.certific  |Paste the IDP Signing Certificate you copied.

12

13

Run the build-metadata.bat command using these parameters: build-metadata.bat /OP /STS
sp.properties idp.properties. This command creates a populated set of fedlet metadata in the

fedlet_config folder.

Copy the fedlet_config folder to the root folder of your SiWA server or for an IBM i deployment of SiWA.
The root folder to use should be the ROOT folder of the IFS.

Note: This path is already mentioned in the Java runtime changes completed in the “Copying the fedlet

metadata folder” section.

System property changes

1

Locate the System i Workspace AnyWhere system.properties file as documented in the System i
Workspace AnyWhere Installation & Administration Guide. Add the following properties and change

the slo url:

com.infor.siw.cloud.mingle.slo.url=https://slo-hostname.domain.com
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https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSSO
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSSO
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSSO
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSSO
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSLO
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSLO
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSLO
https://sts-hostname.domain.com:9553/inforsts/infor/00000000000000000000000000000000/idp/samlSLO

Note: You can use the URL, minus any context path, from any of these locations:

* idp.adfs.location
* idp.sts.slo
* idp.saml.slo.url property value from the file idp.properties

2 Save your changes.

Updating Infor LTR manager application

1 Log into the Infor LTR Manager from your Infor LTR server, then click Applications and locate the XA
application you configured with ADFS in an earlier step.

2 Change the SSO Application to INFORSTS.

The Relying Party Identifier should match the value of property sp.entityid from the file sp.properties.
The SSO URL should match the value of the property sp.sso.url from the file sp.properties.
The SLO URL should match the value of the property sp.slo.url from the file sp.properties.

3 Click ... on the Signing Certificate and select the certificate SiW_Certificate1.cer found in the root
of the fedlet_config folder.

4 Click Open and click Save.

m Application x

Application Name :

Description ADES to STS miaratin instance
Application Type XA(ERPD

SSO Application : INFORST

I

Relying Party Identifier: ERP_X

SSO Url alvwxaios02.infor.com:8443/systemi/(
SLO U https://usalvwxaios02.infor.com:8443/systemi/fedletSic
Signing Certificate : C\Users\jpatan1\Downloads\SiW_Certificate 1.cer
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5 Follow “Updating the Infor STS Server” Section in this same chapter.

Configuring ERP Person IDs in Infor LTR for SSO

Each user that needs access to SiWA must be configured to add a mapping from the Infor LTR
platform to their ERP user, which is their IBMi profile ID. Mapping the IBMi profile ID to ERP Person ID
is done through the User Management interface.

1 Log into Infor LTR and select User Menu > User Management.

Manage ¢ Users

+ a UPLOAD SYNC EXPORTALL USERS IMPORT 11.X USERS
‘ Select Property v H Contains v H X chaitanya
INFOR\vkaja1 Venkata Chaitanya venkatachaitanyakrishna.kaja@infor.com 2/21/2025 Active

2 Use the table navigation or Search function to locate each user profile that you need to change.

3 Click the drill-down option next to the username display their properties.

> |/ Users |/ Venkata Chaitanya Krishna Kaja

Details Additional Properties Security Roles Accounting Entities Locations Groups ERP Person IDs Client Access Activity Custom Master Data Types

First Name * Title Picture

Ver tanya Krishna Software Engineer
Last Name * Department

Kaja Development

Email Opt-Out
Email Address * Manager
enkatachaitanyakrishna.kaja@infor.com INFOR\cchopra Qz © incomplete

Alternative Manager

User ID IFS User GUID

INFOR\vkaja1 INFOR\vkaja1

If you are using Role-based authorization for access to the SiWA application, then ensure that the
user is authorized to the correct role.

4 Select the ERP Person IDs tab.

5 Create a mapping between the Logical ID of the SiWA application and the IBMi username.
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anage [ Users / Venkata Chaitanya Krishna Kaja
Return to sear

Details Additional Properties Security Roles Accounting Entities Locations Groups ERP Person IDs Client Access Activity Custom Master Data Types

+ =]
I T v v N I Sy ey
O chaikri L2M-AA lid://infor.xa.usalil2m-aa

rran |4 | aea A0 Pannrdin nar namn —

In this example, when a user logs in to Infor LTR and accesses the Infor IBMi based application
that runs inside SiWA, uses the ERP Person ID which is the IBMi profile ID of the user.

6 Specify the ERP person ID, ERP accounting entity, and ERP logical ID for the environment, and then
click Save.

7 Repeat for each user profile that needs access to SiWA.

Local Network Access

If you have not already done so, please review KB3645324 Users Are Unable to Access Infor Applications
after upgrading to Chrome version 142 and Edge 143 (or later). Restrictions on local network access in
those web browsers may interrupt access to System i Workspace Anywhere from Infor LTR, if not properly
handled.
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Chapter 9 Drill-back configuration

Drill-back configuration requires the deployment of a configuration file within Infor LTR and Infor
ION. This file is supplied by XA for drill-back support.

Configuring Infor Ming.le drill-backs

To configure drill-backs in Infor LTR, you must import the XA_Standard_Views.xml Drillback
Definition File.

1 Navigate to the infor\vlib\Ming.le folder in the client IFS directory, which is the location of the
XA sample solution files used for integrations through Infor LTR and save the
XA_Standard_Views.xml file.

2 Log on to Infor LTR as the administrator.

3 Click your User Menu and select Admin Settings. You require an Admin profile to manage
drill-backs.

Q, Start Typing a M

0 Venkata Chaitanya Kris...

Admin Settings .

User Settings
User Management
Social Data

Apps & Authorizations

Help

About

Sign out

4 When the Admin Settings load, click Manage Drillbacks. A list of drill-back definition files that
are uploaded is displayed. Upload latest drillback xml if needed.
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Admin Settings
Manage Applications Manage Context / Utility Apps Manage Drillbacks General Settings

Manage Drillbacks -+ UPLOAD DRILLBACK XML

Content Type

Application 5 Description 5

infor.daf Infor Document Management v12.0 Standard
infor.inbox Infor Inbox Drillback Views Standard
infor.eam EAM Drillback Views Custom
infor.wm SCE - WM Content Custom
infor.xa XA Standard views Custom

5 Click UPLOAD DRILLBACK XML and browse to select the Drillback Definition.
6 Click Open.

7 Click OK. This step will override the old with new drillback defiintions.

Manage Dnitbacks = UPLOAD DESLLBACK XML
| \ Tt 4 lor XASIW)-05 » &t backs v G p n
Owgenae = New ltider - )
indor
bow 10 Docs A A
| 10F nszats Sack -l
” on *Ch_~ape »
infor eam Indce [maks - Gowsham - U,
Nyperinks wmi
Infee 05 -G
wd o xawmid
indoe caf irdee OS5 Documentation
883 daomd
L irfee XAISM-OS 2
8 83 Samd
ndor wen L Socumentation
o XA_Standad Views s v
Sl Bacis v ¢ >
e name: | v XM Docusent (*ami) v

Open Cancel

Note: Apply the Infor OS Registry fix to resolve the SiWA Drill Back issue. This fix needs to be
installed by customers by following KB3569277 for all releases older than LTR 2025.06. LTR
2025.06 will have this fix included.
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Drill-back definitions

These Drillback Definition files are used in Infor LTR to generate the drill-back links for ION
tasks/alerts.

Drill-backs are supported from InforBusinessContext messages which are shared in SocialSpace or
subscribed to by other Infor LTR applications. Each InforBusinessContext message supported by
XA IDF includes a drill-back URL the receiving product can use to drill back into XA. These
drillbacks are often referred to as InforBusinessContext Drillback.

Drill-backs are also supported from products integrated with XA using ION and BOD messages.
Products such as Infor Reporting and ION analytics require additional configuration; see their
respective guides. A drill-back can be requested to XA and the appropriate related task can be
launched. These drill-backs are often called BOD DrillBacks.

This table shows the ERP XA supported drill-backs that include these BOD nouns:

BOD Infor XA object
AccountingEntity Accounting Entity
AccountingChart General Ledger Account

Administrative Division

AdvanceShipNotice Shipment Notice
Shipment Container
Shipment Container ltem

BillToParty Entity
Financial Division Vendor
Customer Company

Account
Carrier Party Carrier
ChartOfAccounts General Ledger Account Nature
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CodeDefinition

Business Information Services
Financial Division

Company

Payment Term Code File Unit
Warehouse

Site

ContactMaster

Contact

Contract

Customer Quote
Customer
Contract Quote

CustomerPartyMaster

Customer

FinancialCalendar

Financial Division

FinancialPartyMaster

Entity

Financial Division

Vendor Customer

Company Account

ItemMaster

Item Revision ltem
Warehouse Item

Invoice

Financial Transaction
Customer Invoice

Location

Company Site
Financial Division
Warehouse

Opportunity

Opportunity

PayableTransaction

Financial Transaction
Vendor Invoice
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BOD Infor XA object
PayFromPartyMaster Entity
Financial Division
Vendor Customer
Company Account
Person Buyer
Sales Representative
ProductionOrder Manufacturing Order
PurchaseOrder Purchase Order
Purchase Order History
Quote CustomerQuote Quote
RemitToPartyMaster Entity
Requisition Purchase Request
SalesOrder Customer Order or Quote
Customer Order History
ShipFromPartyMaster Entity
Customer Ship To

SourceSystemGLMovement

GL Account Period Balance
GL Account Period Budget
General Ledger History
General Ledger Activity

Supplierinvoice

Financial Transaction Vendor Invoice
Customer Receivables

SupplierPartyMaster

Entity Vendor

80 | Infor XA Configuration Guide for Infor LTR using System i Workspace AnyWhere



BOD Infor XA object

SupplierQuote Quote

SupplierShipmentSchedule Purchase Order
Purchase Order History

TradingPartner Entity
Financial Division Vendor Customer
Company Account

Using drill-backs in Infor LTR and context/utility app

To use the drill-back functionality in Infor LTR and Tasks Context/Utility Apps, configuring drill backs
and enabling Tasks Context/Utility app for that XA environment in Infor LTR is a prerequisite.

1 Click Inbox > Tasks in Infor LTR to view Activity Feed > My Tasks.

Gonnections + My Tasks (1)

d The PurchaseOrder P000581 2022-10-03 has been created
+ CREATE A GROUP b
2B 1 Show Detals | Goto Inbox | Share

2 Click Show Details to open and select the Drillback link as highlighted in this screenshot.
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Task «

The PurchaseCOrder P000581.2022-10-03 has been created

Yesterday at 7:21 PM

e Re) I | ASSIGN

inforPulseTask:49  #inforF flow:63

DONE

Parameters

D P000581.202 AE: L2M-AA
LID: lid:/finforxa.us... e

Attachments

g Add Attachments

Workflow Progress Indicator

b 3

3 Click the Drillback link. The page is redirected to the specific XA object. In this example, the
page is Purchase order.

System i Home Purchase Order
P0O00581 Vendor: 161616 161616 Cus Ven-TD Buyer: 100 Judy Camin
Continue: File .| | Display « | | Maintain . | | Customize » | | Navigation . | | Help « Default (R7) GO AME0 QO0ORNEEFRER &I

Vendor Preferences  Vendor Address  Ship-to Address  Bil-to Address  ltems  Variance  Amounts  Dates  Overview  Replication  Approval ~ Comments  Attachments Global — Attachments Overview

Order stalus:  Accepted
Revision: 0
Invoice status:  No
Buyer 100 O]
Name: Judy Camin
Vendor: 161616 [0Y)
Vendor name: 161616 Cus.Ven - TD
Warehouse:  ATL (D)
Create date:  10/03/2022
Confirm by date:  (blank)
Release date:  (blank)
Priority: None
Hold from print:  No
Omit item quantities on P.O.:  No
Print special charges: No
Approval status:  Approved

Request approval: No

Count of externally controlled items: 0

Configuring the IDF Context application

You can configure the IDF Context application in Infor LTR. When configured, the application is
displayed on the right-side of the window.

To use the IDF Context application, System i Workspace must be at PTF level 16 or later.
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Enabling IDF Context applications

1 InInfor LTR, go to Admin Settings > Manage Context/Utility Apps. Context App Primary
View, Context App Secondary View, and Context App Tertiary View are displayed.

C M s eucelvwsunsup47.infor.com/infor/38833fa6-fb2f-4843-b5a2-8c929580dc8b~ADMINPAGE

3 mfor [3 10N trm... \ [ sECertification [ EAM  [J SIMPTF [ CRM _Learning [J CPQ

Infor Ming le™

Display Name *

L2M-AA(Tomeat)

Change lcon

Deployment Information Permissions Context/Utility Apps Custom Parameters Logical ID Fallback

Context/Utility Apps
Context Apps are lightweight appiications that communieate with the application frame to publish contextual information to the user. These applications subscribe to information published by the application
frame and display relevant content only when itis available.

Utiity Apps are lightweight applications that represent information unrelated to content in the application. They do not communicate with the application frame and, f activated, show only when the application
is open

Add/Remove Context/Utility Apj

1-Context App Tertiary View

ns v

= Context L ]
Edit Screen 1D Associations ortext App
2:Context App Secondary View .
Edit Screen ID Associations = ContextApp
3-Context App Primary View
Ecit Screen ID Associations = Context App ®
2 Click Context App Primary View to view the details.
Manage Applications Manage Context / Utility Apps Manage Drillbacks General Settings
Context/Utility App Details
Name *
Context App Primary
Type *
Context App -
Description *
Context App Prima:
Vi
Permissions Context Message Applications
“_
O 1 XA-User IFSSecurityRole lid:/finfor social.instance01, lid:/infor xa usalil2m-aa
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3 In the Permissions tab, add the security role created for XA in “Create a new application
security role”. All the users under this security role can view this Context App while accessing
XA.

4 Select the Context Message tab and add these messages as displayed. Refer KB2046253 for
more details.

Context/Utility App Details

Name *

Context App Primary View

Type *

Context App

Description *

Context App Primary View

Permissions Context Message Applications

Delete  Add Message

Message Name

inforBusinessContext

] SIWALcgout

] SiWALogin

5 Select the Applications tab and enable the toggle for required XA application.

Permissions Context Message Applications

Delete Add/Remove Applications

[] Application Name and Version Logical ID Enabled

XA-9.2 lid-/finfor xa usalil2m-aa

6 Launch XA and click the double arrow option in the top right corner to launch Context apps.
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.se My Notes see

System i Home

O, +

Context App Tertiary View

Context App Secondary View v

Context App Primary View ~
My Tasks i v

»

- IDF
= @ Settings (XA_PBK_LIST)
Business object

(first entity)
Card

(object preference)

O Set as preference?

O Record entities?

[ondo I coninee

Drill-backs in Task Context/Utility app

Tasks Utility App enabled in Manage Context/Utility App enables users to view the tasks in the
right-side corner of SiWA System i window. A list of tasks available for the current user is displayed.

1 Click More > View Details. The Task details window is displayed.
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System i Home Purchase Order

EO ~ -

My Notes

My Tasks

>»

& [ IDF
=D My Notes

2 Click on the drill back symbol to view the drillback link.

. Task

The PurchaseOrder P000581.2022-10-03 has been created.

XA PO Drill

ASSIGN TO ME ASSIGN

inforPulseTask:49 #inforPulseWorkflow:63

DONE
Parameters

ID: P000581.202...

LID: lid://inforxa.us... ses

3 Click the drillback link to launch and redirect to PO details in XA.
Vendor: 161616 161616 Cus.Ven - TD Buyer: 100 Judy Camin

-

Tasks ~

1 Selected ASSIGNTOME CANCEL

G)I ¢ [ Category All v

The PurchaseOrder P000... ===
YESTERDAY AT 7
7 View Details

«§ Share

[ Assign to me

AE:

Continue| | [File .| |Display + | | Maintain s | | Customize « | | Navigation « | |Help | | [Default (R7) rxck.-] 2T T0h oA RERRE | FgeoevadBREL

Vendor Preferences  VendorAddress  ShiptoAddress  BilHoAddress  liems  Variance Amounts  Dates  Overview  Replication  Approval  Comments  Attachments Global  Attachments Overview

Order status:
Revision

Invoice status:

Buyer

Name:

Vendor:

Vendor name:
Warehouse:

Create date:

Confiim by date
Release date:

Priority

Hold from print

Onmit item quaniies on PO
Print special charges:
Approval status:

Request approval

Count of externally controlled items:

Accepted

0

No

100 (o)
Judy Camin
161616 [0
161616 Cus Ven - TD
ATL (O]
10/03/2022
(blank)
(blank)
None

No

No

No
Approved
No

0
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Chapter 10 Infor Business Context

The Infor Business Context (IBC) message is an Infor Ming.le standard message that broadcasts the
status of an application. The message consists of the identity of the application and the view that is
being displayed along with a list of entities.

All Infor applications running inside Infor Ming.le send these messages. In IDF, the entities
correspond to the business objects that are currently being displayed.

In list view, the IDF always sends a message when the selection changes. The message contains an
entity for each selected row.

In object view, the IDF sends a message containing the displayed object and any many-to-one
related objects. When the user selects a row from a list card, the currently selected object is added to
the message.

Context applications or web parts can be added to any application page in Infor Ming.le. These
context applications display data that is appropriate for the message.

The IDF context application listens for IBC messages and when the context application receives a
message and recognizes the first entity, the context application looks at the preferences for the
corresponding business object to see if a card preference has been defined. If a card preference is
defined, then the IDF context application displays the object using that card preference.

[® | [Fie.| Display s Mainiain ) [Customize s | Navigation s | [Fislp | | [General (ol racords) AQp@FO0d RsrME0 B BRLEAKES D Context App Primary View -~

Coat Order Stats Customer  Soldn Whs  Orderdate  Reference Sales Contract Request

co 915 w0 103 CSM7 6 Customer 2 AL 0212025 021112025

co 94 10 103 CSM 76 Customer 2 ATL 02062026
co 913 10 103 CSM 7.6 Customer 2 ATL 02062025
c 912 W 103 CSM 7.6 Customer 2 ATL 02052025
co 9 10 103 CSM 7.6 Customer 2 AL 020572025

1
1 0200612025
1

1

1

1¢c0 90 15 103 CSM 7.5 Customer 2 AL 01242025

1

1

1

1

020672025
020572025
020572025
01242025

(object preference)

] Record enlities?
co %8 15 103 CSM7 6 Customer 2 ATL 017242025 -

011242025
011072025
01102025

010972025

co 908 10 103 CSM 7.6 Customer 2 AL 002025 =

co 07 10 103 CSM7 6 Customer 2 ATL 01102025
co W6 10 103 CSM 7.6 Customer 2 AL 0102025

You can select the Settings option and select a business object and a card from the list. In this
example, Customer Order and Attachments Overview are selected, respectively.
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X Customer Order X Context App Primary View A

Customer Order -
BO® | BLMTO 2l L

Order Totals

Settings (XA_CORCOR)

verview  Comments Processing Options ~ Currel More...

Business object
Customer Order
Card

Attachments Overview

[0 Set as preference?

O Record entities?

m Continue

Line items are displayed when you click on the customer order as displayed in the screenshot.

= System i Home: Purchase Orders X Customer Order @l Context App Primary View
1 Customer. 103 CSM 7.6 Customer 2 Order:CO 913 Customer Order

Continue| | [File «| | Display | | Maintain | | Customize + | | Navigation | | Help. | | [Default CRO® | RrMoo B B&Li» et
Pricing/Billing ~ Solddo  Shipto  Order Shipments ~ Commissions ~ Line flems ~ Holds ~ Special Charges  Oyerview ~ Comments  Order Totals  Processing Options  Currer More. ticaion

Warehouse: ATL [0y Purchase Order

[ Customer Order-1,1, 913

Manufacturing due:

02/06/2025

Ship-to:  (default) Number:  (blank)
Sales:  Regular crdit sale Date:  (blank)
Order reference:  (blank) Revision:  (blank)
Sales representative: 450 [0y Totals
Language: 001 = Defaultlocal language Volume:  0.000
Dates Weight:  0.000
Order. 0200612025 Value: 906,210.00
Request  02/06/2025 Invoice amount:  906,210.00

Related Information

Preference definition in XA 9.2

Preferences for the context application for any business object are defined in Power-Link.

1 From the main browser, double-click Business Object to configure the context application.
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H (EE) Infor ERP XA Power-Link on USALIL2ZM

File Customize Navigation Help

. O

Defaut .

Infor XA

CA Plus
a 4 ; Customer Relationships
i;@ @ @ \'f‘“‘ =) e Customer Service
ltems Warehouse Buyers Vendors Purchasing Purchase Requests Purchase Request Contracts Requisitions Engineering
Addresses Activity History Materials
= . . = [ Production
HE s 5 o2 g o
Requisttion Quotes Purchase Orders Purchase Order Purchase Order Purchase Order Warehouse Vendor Procurement
History History ltems History items tems Planning
& & | Environmert
Material Logistics
Standard Messages  Other Procurement Vendor ftems Integrator
Tasks Integration
PO ftem Release
Procurement Codes I
Powered by [JTa]
|
2 Select Customize > Preferences.
ﬂ (EE) Purchase Orders
File Display Maintain Customize User Navigation Help
Geneml = Presentation >h B & D g
R Query ...
@ Purchase Ord “ i
5 |3 Locate ... Ctrl+L
Order i | Vendor BE Wworkspaces ..
PSSNO01 VEN
PSSN002 VEN .
psitas  |sw | B Vews.
PS$1146 SW | 3p Subsets..
PSS1158  [SW | —
PSAB001  [100 &= Soris..
PSAB002 100
PSAB123  [100 Cards ...
PSAB124 |100 | __
PSAB125 (100 Card Fies ...

PSAB126 100

PSAB128  [100 Broadcast

PSA0001 VEN

PSA0002  |VEN , y

el b £, Preferences ... o
PSA0004 VEN Vendor Entity for L2MAsE

PSA0005 VEN
pDeANNNG \/EN
<

Vendor Entity for L2M Customize preferences]

Vandnr Entihe far | JUTTE T

|Customize preferences
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Purchase Orders o

[® | [Fie. |Display.| Mainain .| [Cuslomize .| | Navigation .| |Help .| | [General (R7) {all records) QD¢ 0od Rs/MED | CQORREERR Fus aS2AE 289
Order v Priory Vendor | Query Orderstatus  Held Approval  Relesed  Confimby  Confimad Rev Revised  Buyer Name L]
P2020 0 R 20 = Accepted Appraved 0 100 Judy Camin
PIB1602 161616 | Cuent 50 = Complate Approved 0 100 Judy Camin
P12345 Y Vetkspacs 20 = Accepted Approved ] 00 Judy Camin
P1000 10 \:‘e;::‘ 20 = Accepted Approved ] MFC2  MPACOMPONENT 2
PODO3SG MPART | g 20 = Accapted Approvad ] MATCH  Match Vendor Buyar
PO0OSSS JCENZ Cards. 20 = Accepled Approved o MPC2  MPACOMPONENT 2
PODOSS4 A0 Card Files 20 = Accopted Approved o 100 Judy Camin
POD0593 = Approved 0 UNKNOWN BUYER (DEF
PODOSE2 Cobal Pferences . | = Approved ] UNKNOWN BUYER (DEF
PODOSS1 = Approved [] UNKNOWN BUYER (DEF
PODOSE0 JCENZ  JC Entity 2 JPY 20 = Accepted Approved ] MPC2  MPACOMPONENT 2
PODOSEY 10 SMITH 35 = Inveicing com Approved ] RBZ  Alan Smith
PODSEE 10 SMITH 30 = Receiving sta Approved 1 1162022 RB2  Alan Seith
FoB0sET 10 SMITH 20 = Accepted Approved 0111612023 0 RBZ  Aan Smih
PODOSEG EAMI2 SUPPLIES EAM 30 = Receiving sta Approved [] MPCT  MPACOMPONENT 1
PODOSES 10 SMITH 30 = Receiving stz Agproved ] RB2  Alan Smith

]

POBOSE4 161616 161616 CusVen-TD 20 = Accepted Appraved

100 Judy Camin

The Purchase Order Preferences screen is displayed.

(EE) Purchase Order Preferences X

i| Workspace | List I Card File | Template Find Broadcast

Buyer (public preference)

Warehouse |(public preference)
Options
Flag changes as revisions | (public preference)

Receive Complete
Template  (last used) v

|  Continue | Cancel Help

3 Select the Card File tab, and then select the Net-Link tab.
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n (EE) Purchase Order Preferences X

General Workspace List Card File | Template l Find l Broadcast I
Initial selection | (public preference) v | Powver-Link |
Net-Link |
Initial card (public preference) v
Context application content
Primary | Addresses All v
Secondary (public preference) v
Tertiary (public preference) v

|

4 Specify the preferences for the context application. In the example, Addresses All is selected.

The context application content area is where the cards that are to be used by the IDF context
application are defined. You can use any cards, but most cards are designed to be used in a full
screen and may result in unwanted scrollbars when presented in the limited space available to
the context application. We recommend that you define specific cards using the customization
features of Power-Link specifically for the context application. See the context help of Power-Link
for guidance about how the customization facilities are used.

See the “Export Metadata from XA” section in Infor System Manager Quick Installation Guide for
Infor XA after setting up preferences in Power-Link to reflect the changes made in Power-Link
export Private metadata.

After exporting the metadata, Workspace must be updated for the existing or new users. See the
“Updating Workspace” section in Infor System Manager Quick Installation guide for Infor XA.

5 Launch XAin Infor LTR to see the Context App Primary View with Addresses. Select a purchase
order in the Context App Primary View to display the Purchase orders Addresses.
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System i Home Purchase Orders X

Context App Primary View A
thase Orders AR
Files Displays Matans| Users [Heps QD@ O @ R 2T D R o vendo
Order Vendor  Vendor name Total Currency Apr Pt VAc Rov  Inv Od  Release Rev RevEj -
;) PSSNOO1  VEN Vendor Entity for L2M SE 46000 v a w“\':{"; ;99[0301
) PSSNO02  VEN Vendor Entity for L2M SE 230,00 v & @& 1212812021 o
W
L o -
3 PSS1158  SW SupplyWEB 334.56 v a2 (blank)
) PSAB0O1 100 Dick Samuri 10.00 v a2 City:  Alpharetta
] PSABO02 100 Dick Samuri 10.00 v 2 State.  GA= Georgia
PSAB123 100 Dick Samuri 100.00 v a Postal code: 30005
PSAB124 100 Dick Samuri 10.00 < 2 Country:  USA = United States of America
) PSAB125 100 Dick Samuri 10.00 v a2
) PSAB126 100 Dick Samuri 10.00 < 2
PSAB128 100 Dick Samuri 10.00 v 8 a 12/29/2021
s neannne  vew VieedeCose.ciovioc snen z ~

Preference definition in XA 10

Preferences for the context application for any business object are defined in Net-Link and can be
configured in SiWA.

1 Open the Business Object and select Customize > Preferences to configure the context
application.

= Infor Development Framework Purchase Orders
Purchase Orders
] File 4| | Display 4 | Maintain . [[GUSlamize 4| | Help 4 General (all records) - QD@ O™ B2TT D0
Order a1 Vendor Vendornam Query ... Total Currency Apr Prt V... Rev Inv Ord Release Rev Revised
J PO00001T 100001 Carbon fibe -OC3(€ - 2,000.00 v & 2 E 07/07/2022
3 PO00002 100003 IT hardware CUr™ent. 2,300.00 v &
Workspaces ...
3 P000003 100004 Helmet Sup 150.00 < 2 B
PO00007 100004 HelmetSup - o 1,000.00 v 2
3 elmet Su ,000.
P Subsets ...
Sorts ...
Cards ...
Card Files ...
Preferences .
Global Preferences ...

2 Select Object tab. Under ming.le Context Apps Cards you can select the required preferences
for Primary, Secondary, and Tertiary applications. Bill-to-Address is selected as Primary
Application preference in this example.
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£¥ Purchase Order Preferences

General List

Card File

Initial card file:

Initial card:

(oL@l Find

(public preference)

(public preference)

ming.le Context App Cards

Primary:
Secondary:

Tertiary:

Templates

Create:
Copy:
Change:

"Bill-to Address

(public preference)

| (public preference)

kpﬂblic préfeFence)
‘ (public preference)

| (public preference)

Maintenance history

CGonive J Gancet | b

B By by @

one] Bokel
et O il

3 Click Continue.

4 From the Purchase Orders list select a PO. Go to settings for Primary Context App on right side.

QD& ©&

Rcv

Ensure that no Business Object and Card details are selected before.

Ord Release

mom h ok

210

Rev

&
©

Re B

Purchase Order

We

=]

Settings (XA _POR_LIST)

Business object

| (first entity)

Card

(object preference)

O Set as preference?

O Record entities?

Cundo J Coninue
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5 Click Continue.

6 From the Purchase Orders list, Select a PO to see bill to address details in Context app Primary
View.

System i Home Purchase Orders X

Context App Primary View ~

Purchase Orders o
Purchase Order
8 4 Display s+ | Maintain 4 | Customize « avig al |k "
= File 4| | Disy Maintain 4 | | Customize + Navigation elp General (RT) (all records) QD& Q©Ep Werehouse: LS1 [0
Order w  Priority Vendor Name Order status Hald Approval  Released Confrmby  Confirmed Rev Revised L] Bilto 998 [B)
T SR R = ey o ey ., v
Name'  billta
PO00576 A100  MAINADD 30 = Receiving sta Approved 0 2
Address 16 plain
PO00S75 A100  MAINADD 30 = Raceiving sta Approved 0 2 bl
ank)
PO00574 A100  MAINADD 30 = Receiving sta Approved 0 2
City  Aflanta
PO00S73 A100  MAINADD 20 = Accepted Approved 0 % )
State GA = Georgia
PO00572 A100  MAINADD 20 = Accepted Approved 0 2 sl code. 115
PO00ST1 EAM1  SUPPLIES EAM 20 = Accepted Approved 0 2 Country: USA = United Stales of America
PO00570 A100  MAINADD 20 = Accepted Approved 0
PO00SEY A100  MAINADD 20 = Accepted Approved ]

7. Purchase Orders list with Context App Primary, Secondary, Tertiary View.
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Purchase Orders

Context App Primary View ~

Lo Purchase Order %

SRR | FueAPRRE| 2

5 Purchase Order - 000569

4P

Warshouse:  LS1 [0

1, Bilto: 988 [0

Processing Finance  Status  Variance  Contacts

Name:  hill to

E Mot approved  Approved

Order:  PDDDSGE m o ' More... O Show comment separators Effective date: | 0
Created:  05/24/202
) Werehouse: 181 (0 || [ERRE Clossouw Intemal
Buysr: (blank} I .
Shipto: gee (O]
UNKNOW .
Mame:  shipto
Status:  Accepted Address: 13 plain
(Blank)
‘eproval staus: - Approved City:  Atlanta
Request approval:  No Stater GA= Geo
Fostal code: 31115
Country: USA=Un
ltems
o ® | 2T | Q0 Details: | General -|
Identification Wareh... Contract Quantity UM A
Bl Linez1 LS1002 LS1002 PART Ls1 0.200 EA
Extended amount Tax estimate Freight estimate Special charges estimats Total
13.00 0.0 0.00 0.0 16.00
16.00 0.00 0.00 0.00 16.00

18 plain
(blank)
City:  Atlanta
Siate: GA= Georgia
Fostal code: 31115
Country:  USA = United States of America

Context App Secondary View ~

Purchase Order %

Tlacig CANTENCY Local currency

Estimate Actual

Invoice:  16.00 0.00
Freight: Q.00 0.00
Special charges:  0.00 0.00

Context App Tertiary View ~

Purchase Order *

Vendor: A100 [0
Name:  MAIN ADD
Address: 1315 POND ROAD
SUITE 009
City:  MEDWWAY
State:  MA=Mazsachusetts
Postal code: 02053
Country:  |USA= United States of America
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Chapter 11 User maintenance

This chapter only covers minimal user maintenance. You must refer to the Infor LTR Administration
Guide for the complete documentation of the features described here.

Adding users

1 Log into Infor LTR using the account that you set up for IFS administration.

2 Click the User Menu option in the top-right hand corner, and then select User Management.

Q, sta

e Venkata Chaitanya Kris...
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Click the + option to add a new user.

5] UPLOAD SYNC EXPORT ALLUSERS  IMPORT 11.X USERS Select Property * || Gontains - a

('] INFOR\aderr ‘Alan Derrick ‘Alan Demcki@nfor com 172472025 12 29:58 AM Active
= o Aberto Viveros Actve
Specify a name in the search box and click Load.
Add Users <+ abD X CANCEL
Path User Filter
Boots\rap v Comalns v X svudu Q LOAD
L T
. INFOR\svudumula Sairakesh Vudumula sairakesh.vudumula@infor.com
Select the user from the list and click Add.
Manage / Users
—+— a UPLOAD SYNC EXPORTALL USERS IMPORT 11.X USERS
| Select Property v H Contains vl
INFOR\svudumula Sairakesh Vudumula sairakesh.vudumula@infor.com

Verify the user information and update as per the business requirement.
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First Name * Title Picture
Last Name * Department -
St
dumu Development
Email Opt-Ou
Email Address ™ Manager
airakesh.vudumula@infor.com NFOR\cchopra Qz © incomplete
UPN * Alternative Manager
User ID IFS User GUID
FOR\svudumula NFOR\svudumula
FS ION-Person ID * M3 User Alias

sairakesh.vudumula@infor.com

7 Go to “Security Roles” and click the “+ symbol to add the required security roles to a user as
per the business requirement.

Select Security Roles + ADD -+ ADD&cCLOSE
E Q
E_
XA-Administrator This role may have lid://infor.social.instance01,
lid://infor.xa.usalil2m-aa e
|:\ XA-User This role may have XA lid://infor.social.instance01,
lid://linfor.xa.usalil2m-aa M

8 Click on “ADD” or “ADD & CLOSE” after selecting required security roles.

9 Click on “Save”, to save the changes to the user profile.
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Chapter 12 Net-Link WAR file redeployment

This section explains the procedure on Net-Link WebArchive (WAR) file redeployment. We perform
in this section only when we want to redeploy the Net-Link war file with new changes.

System i Workspace AnyWhere with Windows
deployment

Refer “WAR file Generation” and “Tomcat (version 7.0 +)” sections in the Infor XA Setup Guide
for Secure Net-Link, which describes the Net-Link WAR file redeployment with SiWA using
Windows deployment.

System i Workspace AnyWhere with IBMi

deployment

Refer “WAR file Generation” and “WebSphere (version 9.x)” sections the Infor XA Setup Guide for
Secure Net-Link, which describes the Net-Link WAR file redeployment with SiWA using IBMi
deployment.
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Appendix A Publishing BODs

Use this appendix to understand how to publish business object definitions (BODs).

Business Information Services

The BIS Organization node setting in XA is used by all BODs as a base accounting entity for many
different BOD elements including document ID’s. The Code Definition BOD is used to send the list of
accounting Entities to the Business Vault.

It is recommended the BIS organizationNode (“machineName.EnvironmentCode”) on the Business
Information Services card in the Application Settings object is not more than ten characters. For
example, if machine name is USATLDO6 and environment is AB, you can use either USATLDOG6 or
D06.AB or any other combination of characters that is less than or equal to ten characters.

If you change the Organization node attribute for the root Organization Node accounting entity, the
PUB* files storing published data for many objects are not changed. Also, the root Organization
Node accounting entity in the Business Vault is not updated even if you run the Publish Business
Information Services host job on the Business Information Services card in Application Settings.

If the root Organization Node accounting entity is changed in BIS, you must do these steps:
1 Clear all published data files (PUB***) for the environment.

2 To rebuild the PUB* file data as well as re-sync of BV data, re-publish all published objects
including objects that publish Code Definitions and Accounting Entity.

3 Use the Publish host job on each object to publish BODs.
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Appendix B Creating a default WebSphere profile

If you are unable to get the default profile from WebSphere profile dropdown while creating an
IBM HTTP Server instance, follow these steps to create default WebSphere profile:

1 Start a QSH session in iseries.

- s ¢ it | UL - o

IBM | Main Menu

(C) COPYRIGHT I18M CORP. 1980, 2015
M l t 207013

2 Run these commands:

$ cd /QIBM/ProdData/WebSphere/AppServer/V9/BASE/bin

S ./manageprofiles —-create -serverName serverl -nodeName <hostname> -cellName
<hostname> -hostName <hostname.domain.com> -templatePath
/QIBM/ProdData/WebSphere/AppServer/V9/BASE/profileTemplates/default
profileName default

Replace <hostname>, <hostname.domain.com> with the relevant iseries hostname.
For example:

$ cd /QIBM/ProdData/WebSphere/AppServer/V9/BASE/bin
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$ ./manageprofiles -create -serverName serverl -nodeName usalil2m -cellName
usalil2m -hostName usalilZm.infor.com -templatePath

/QIBM/ProdData/WebSphere/AppServer/V9/BASE/profileTemplates/default
profileName default

- T A+ USAIRA =) -

Note: In some severs the folder “BASE” is “Base”. Check the folder structure before running the
command.

3 Return to the WebSphere HTTP admin -> HTTP servers -> WebSphere applications server.
The default profile is listed in the list.

If you still have issues while creating the default profile, check with IBMi support and get this
resolved.
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Appendix C Internal server error resolution

At the end of SiWAnyWhere installation, try to verify the installation, if you are receiving an Internal
Server Error.

b D) rerpr/ fndlm indor.com) system/install-vendy htmi « @ Cenificateerror C | Search.. 5
& 500 lnternal Server Erroc

Internal Server Error
The server encountered an mternal error of muscoafiguration and was unable to complete your request
Contact the server admmustrator at [no address grven] to inform them of the tane this error occurred, and the actions you performed just before ths error

More mformation about this error may be avadable n the server error log

Use these steps to resolve the issue:

1 Login to IBM i Web administrator console.

http://<hostname.domain.com>:<port>/HTTPAdmin

Replace <hostname>, <hostname.domain.com> with the relevant iseries hostname.

For example: http://usalil2m.infor.com:2001/HTTPAdmiIn

2 Stop the HTTP server and application servers related to SiWAnyWhere.

3 On the IBMi server (Ex: USALIL2M), check if the file - plugin-key.kdb is present in this location:

QIBM\UserData\WebSphere\App Server\V9\Base\profiles\<profilename>\config\lHS_WSANYWH
ERE\

4 If the file - plugin-key.kdb is not present, then copy the file from:

QIBM\UserData\WebSphere\App Server\V9\Base\profiles\<profilename>\config\cells\<cellname>\
nodes\<nodename>\servers\IHS_WSANYWHERE

To:

QIBM\UserData\WebSphere\App Server\V9\Base\profiles\<profilename>\config\lHS_WSANYWH
ERE\

Note: You must have QSECOFR authority to perform this action.
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Directory > Apply and click Save.

Start the HTTP server and application servers related to SiWAnyWhere.

Launch https://usalil2m.infor.com/systemi/install-verify.html.

If you still receive an Internal Server Error, then navigate to the WebSphere Application Server
> Launch Administrative Console > Servers > WebServers > IHS_WSANYWHERE >
Additional properties > Plug-in properties and select Copy to WebSphere KeyStore

Yo v
ot At b porvery > BN IRANYWRER] > Pogie prpesies Pl ey
. r ol
e 0 Gl | ot o g ™ i g
L w oo v 8
-— D
ok Page by
Rladal Aot o Brocees
D
» e lisies
rs .
» oo ) “" -
ottty -
e >
*een .
2 by \
Regoadary copy of Web servee phug- flew
# nm= pom—or
0 - e ——————
Py -
& SRy e ey a
max < st
¥ aay
o v —— B nsmsashy s
=
e
Mg bays and ot |
—_—
Sy o Bt wvvw Ao g e
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Appendix D Troubleshooting

1 If user can login to Infor LTR and SiWA applications, but facing an issue at Context App
Primary, Secondary & Tertiary Views with an error message “You are not currently logged on”
displayed, then as a workaround, right-click the respective Context App view and click the
“‘Reload frame” as displayed.

...........

2 Even after the successful SIWA environment setup, if the environment is launching with no
IDF tasks under My Tasks in home page, then you need to check whether exporting is done
successfully or not in the ExportPublicMetadataToWorkspace.log at the local IDF logging
folder. This is similar to going to Power- Link > help > About > Ctrl + D > Ctrl + L and

going to logging folder.

If you find any errors, those need to be resolved and re-run export metadata again to ensure
that you do not encounter any errors.
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» ThisPC » Storage{(D:) » sala » IDF_Cormetto » cache » chent » USALIL2C_36001 » 54 » logging

N temp
<095
ExportPublicMetadataToWorkspace.log

2060
US00U

3 If you encounter the “Language Code is not defined” error, then you need to cross check and
update language code in SIM console.

XA100 Administration Functions
Maint - —

User |

TALARAJ Rajasekhar Talari

Type changes, press Enter and then F3

User level. . . . o o w o om oW e B
[Initial menu

Default sign-on company

Single application task

Default development application

Language code

4 When you try to open any business object from IDF using SIWA, if it displays a blank page,
you need to add the SIWA URL to the insecure content and try to relaunch the application.

2 You and Google < Insecure content
8 Autofill
Insecure content is blocked by default on secure sites

@ Privacy and security
& Appearance

ock
Q Search engine
t Default browser
) On startup T oS
Advanced b
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5

Restart the server SIWA application installed server if below invalid password error observed
for database connection and recheck the Database access under diagnosis in SIWA admin

6

page.

7

echnca Dotals

" GEabane covrecicn

If you receive this request, cross check whether the NLS and NLC processes are in active

state or not, if not start the processes.

@ Infor XA Net-Link

system administator

Press OK to retry

There are no servers available to handle requests. Please contact your

TOoUToT

Net-Link Controller

EF NLC
Net-Link Server

EF NLS

POQC

TYOUTTCOToTT Moo Ug0 oG vaT

(auto)
(auto)

If you face an issue, as displayed, when launching L1 tasks, check if the environment is
pointing to the correct iIASP group or not by navigating to this path in System Manager

Console:

STRM400 > Application Manager - Maintain Environments
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information

m
~
=
1
T
pm

m
=
D

w

o
7

Continue

Application Manager
Maintain Environments

=UPDATE

ype in details and press ENTER to update

To secure Net-Link and launch the SiWA application in Infor LTR, the Globals for the XA
server must be on 9.2. If the globals are on 9.1, then the user cannot download Net-Link.war
file and will fail to secure the Net-Link on SiWA. We do not recommend that you run SiWA on
Infor LTR without securing Net-Link.

If the client system is getting blocked at System Manager (SIM) or if you are receiving this
error while accessing SIWA environments with or without SSO, you must add the IPv4
address of the client system in the allowed clients at SIM.
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© Error During Sign On
Your 1BM i System reported the following Sign In emrors

alilToSy

|

Note: Follow KB2321732 before updating client IP address in SIM.

Navigate to STRM400 - Administration Functions > Secure Sign-on option - Display Access
Log

Identify and copy the client IPv4 address with result as blocked, as displayed.

For example: 127.0.0.1
Display Access Log

Type Client Result
FTOK 127.0.0.1 8/12/7/20 08:19:22 BLOCKED

¢« Press F3 to exit.

* Navigate to Secure Sign-on option > Configure Token generator
Update the Client IPv4 address at Allowed clients, as displayed.

Application Manager

Configure Token Generator

« Press F8 And F3.

10 If, on launching the XA application from Infor LTR, you see a blank screen or one, or both, of
these screens, then Single Sign-On (SSO) is not correctly configured in Infor LTR, System
Manager, SiWA, or all three.
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1

© Ermor During Sign On

System | Workspace Any\Where

¥e C31P0¢ v

User * |~ NO MATCHING ERFFERBON USEF

Compuny | Censnc Damonstranon Company v

Erveonment | System 21 3.1 core -
Remember Mg
& O

Note: Ensure that you have already tested SiWA as a stand-alone application, from a client
PC, and resolved any issues with that setup before enabling any of the SSO features.

If this message is displayed when you try to access any object in XA, you need to logout of
SiWA environment and login to Net-Link environment of this same application. Navigate
through couple of objects and check the objects in SiWA/Infor LTR.
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12

Unfil the first I

Net-Link Task Cannot Be Started

let-Link task has successfully

staried

Close

If you encounter the error “abc.infor.com refused to connect,” where abc is SiWA installed
server hostname, then review this information for your deployment.

B

usalil2a.anfor.com refused to o

L

13 For SiWA with Microsoft Windows deployment: Login to the SiWA installed server with admin
privileges, and from windows search open services, check if the Infor SIWA (SiWAnyWhere)
service is in Running status. If not, then start the service by clicking on Start the service as

14

shown.
Services - e ] x
Fle Acon View Help
&% m Em vrmuwn
Services (Local) - Services Rocsl
Infoe SIWA (SIWAnyWhere) Name Descoption  Status Satup Type LlogOnis
" 58 IKE and AuthiP IPsec Keywny Modules The IKEEXT Runnng  Automat (T... Local Syste.
;u the senvice Q4 Infor SIWA (SIW Ay Where) Infor SOV A Automatic Local Synte
L5 Interactece Serndes Detection Enables ute Manual Local Sysze.
Descrption L& Intesnet Connection Shanng 0CS5) Provides ne Manusl (Tng.. Local Syste
Iofos CON Soc /i ere By old 20031 FDT = —
Services =
File Action View Melp
& m B »euwn
Services (Local) |1 Corvices (Local)
Infor SIWA (SIWAnyWhere) Name Descripticn Status Startup Type Log On As
2 KE and Auth® IPsec Keying Modules The IKEEXT Running  Awtomatic (T.. Local Syste
$op the sernce " A .
Bestadt the service £ Infor VA (SWAsryWhere) Infor SWA.  Running  Automatic Local Syste..

For SiWA with an IBMi deployment: Login to IBM Web Administration console and check if
the HTTP & Application servers related to SiWA WebSphere and Net-Link are in Running
status. If not, then start both the SiWA WebSphere and Net-Link server instances as shown.
Under All HTTP Servers tab, select the SIWA WebSphere installed HTTP server and click on

Start.
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1BM Wed) Adminisration for | Wekcneme PATAIAM

Setup Advancod | Palsted Links

S s Rad e Manage All Servers ©

o Creme WTTP Sane
3 Craste Apsicaton Satwer Al MTTP Servers AN Application Servers

Data cumrent as of Dec 14 2020 550 15 Al

Server o Version Status  Address:Port  Associated Applicadon Server Descripson
O ADMiN ApaPe 2420 M @ Runming 2001 None Acrrarayy pbor yerver
O Alse Apache 4200BMY)  ® S:pped  “A210 Nooe
APACHEDEY AOMPe 420 EMY) @ Swpped 80 L 180 seppled sampie HTTP server (Doweted by Apache )
LNADEY Aache24200M 1) @ Swpped 2020 None |
NUWEBSYR Apache2 420 BM 1) Runming 36201 NLAPPSVR. V3 0 Base HetLink Web serves
WO AQMPe242008M N @ Stopped 1131 tone
@ YSANOMERE Acxre4 WML @ Supped  "44) defaut VO 0 Base
Server sarkp paameters | Ik
Manage Details Delete  Rename

& <5 C A Notsecure | usalil2ainfor.com:2001/HTTPAdmin

# Apps MR IONOSCE @ USALVWXADVXIOl.. @ NewlinforSE® 12.. [fJ Login-inforJIRA [ Infor Xtremelogin @ In)

IBM Web Administration for | Welcome PATAJAN

Setup m Advanced | Related Links

v Common Tasks and Wizar <
B R o e B Start: default/servert ©

jg::‘:“,mw Weicome to the Start Wizard This wizard will heip you start all of the components associated vwith this \Web environment

Select the dems you wish to start
The following application servers will be started:
v default/server!
V' defautWSAnyWhere
The following HTTP servers on the local system are associated with this application server:

E3wsanvwHeRE
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15 If you face an issue, as displayed, when launching L1 tasks, check if the environment is
pointing to the correct iIASP group or not by navigating to this path in System Manager
Console: STRM400 - Application Manager - Maintain Environments

m

User ALASUN

Continue

Application Manager
Maintain Environments

=UPDATE

ype in details and press ENTER to update

16 To secure Net-Link and launch the SiWA application in Infor LTR, the Globals for the XA
server must be on 9.2. If the globals are on 9.1, then the user cannot download Net-Link.war
file and will fail to secure the Net-Link on SiWA. We do not recommend that you run SiWA on

Infor LTR without securing Net-Link.
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usalilZa.anfor.com refus

17 For SiWA with Microsoft Windows deployment: Login to the SiWA installed server with admin
privileges, and from windows search open services, check if the Infor SIWA (SiWAnyWhere)
service is in Running status. If not, then start the service by clicking on Start the service as
shown.

18 For SiWA with an IBMi deployment: Login to IBM Web Administration console and check if
the HTTP & Application servers related to SiIWA WebSphere and Net-Link are in Running
status. If not, then start both the SiWA WebSphere and Net-Link server instances as shown.
Under All HTTP Servers tab, select the SIWA WebSphere installed HTTP server and click on
Start.

Enabling debugging in System i Workspace
AnyWhere

1 Locate the System i Workspace AnyWhere system.properties file as documented in the System i
Workspace AnyWhere Installation Guide.

2 Add this property to enable SSO Debug mode in SiWA:

*  Property: com.infor.siw.cloud.debug
+ Description: Set to 1 to enable SSO debugging specific features of SiIWA

3 Locate the server\xsl folder within your web application deployment.

4 Edit the logon-validate-global.xsl file using a text editor and change <xsl/:variable
name="logindebug" select="""/> to <xsl:variable name="login-debug" select="true"/>.

5 Save the file.
6 Locate the WEB-INF\classes folder within your web application deployment.

7 Edit the log4j.xml file using a text editor and change <Root level="warn"> to <Root
level="debug">.to

8 Sauve the file and restart SiWA to apply these changes.
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Note: You may want to clear or backup any existing log files at this point.

The next time a user logs into SiWA through Infor LTR, debugging information is written to the
Standard Output log file of your web application or server.

Enabling debugging of the identify provider

1 Locate the fedlet_config folder. If you followed the instructions in this document, this folder is in
the root directory of your SiWA server.

2 Edit the FederationConfig.properties file contained within this folder using a text editor and locate
this line: com.iplanet.services.debug.level=error.

3 Change the com.iplanet.services.debug.level setting to one of of £, error, warning, or
message.

4 Save the file and restart SiWA to apply the change.
Note: You may want to clear or backup any existing log files at this point.

The next time a user logs into SiIWA, via Infor LTR, debugging information is written to the debug
folder located under the fedlet_config folder.

Viewing debugging on the ADFS server

1 Within the Windows Event Viewer locate the Applications and Services Logs > AD FS > Admin
as shown.

2] Event Viewer (Local)
p g Custom Views
b s« Windows Logs
4 [ Applications and Services Logs
4 | ADFS
=1 Admin

2 Review all events with a logging level of Error.
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Admin Number of events: 34 (1) New events available

Level Date and Time Source
A, Waming 12/8/2020 11:32:21 AM AD FS
(1) Information 12/8/2020 2:33:41 AM ADFS
(i) Information 12/8/2020 2:33:41 AM AD FS$
(i) Information 12/7/2020 2:33:38 PM AD FS
(i) Information 12/7/2020 2:33:38 PM AD FS
(i) Information 12/7/2020 2:33:38 PM ADFS
A, Waming 12/7/2020 2:33:38 PM AD FS
(i) Information 12/7/2020 2:33:38 PM AD FS

Additional troubleshooting

For any additional troubleshooting steps, see “Troubleshooting Techniques” in the System i
Workspace AnyWhere Installation & Administration Guide.
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Appendix E Multiple SiWA installations on a single
Windows server

If you want to install and run multiple instances of SiWA on a single Windows server using unique
ports for each individual installation, follow these additional settings for each SiWA installation.

1 Navigate to SiWA Installation folder. For example, /tomcat/conf/context.xml file.

2 Edit the context.xml file and change <Context>to <Context
sessionCookieName="JSESSIONID_{environmentID}"> where {environmentID} is the ID of the
environment.

[ contextoomi 3 |

<?xml version="1.0" encoding="UTF-8"72>

E—J [

W n e
1

the Apache Software Foundaction (ASF) under one or more
license agreements. See the NOTICE file distributed with
r addictional information regardi copyright ownership.

IC
ng

o

nses this file to You under the Apache License, Version 2.0
icense®); you may not use this file except in compliance with
ense, You may cbtain a copy ©of the License at

y o
-
o
"

F 4
3 i =

O o
" -
o a
n
r
P

ot
«

-

wmoWwN b

Unless required by applicable law or agreed to in writing, software
distributed under the License is distributed on an "AS IS™ BASIS,
WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied,
See the License for the specific language governing permissions and
limitations undar the License.

L.
o

+
J o

!-- The contents of this file will be loaded for each web application -->
sessionCookieName="JSESSIONID L2MEG"§

0O
{1
I.

<!=~ Defaultc set of monitored resources. If one of these changes, the -
'-—- web application will be reloaded. -—>
fWa:chedResoazce>HBB—IN?/web xml</WatchedResource>
<WatchedResource>WEB-INF/tomcat-web.xml</WatchedResource>
<WatchedResource>§{catalina.base}/conf/web.xml</WacchedResource>

W

i1 &

<!-- Uncomment this to disable session persistence across Tomcat

"
"

starts -->

DD NN NN N
o W N

..
T}
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Restart the SiWA Windows server and ensure that the status of SiWA services is running post
server restart.
2, Senvices
File Action View Help
oo mdc= Eml »enwn

7 Services (Local) |

~

Infor SIWA (SIWAnyWhere) Name Description  Status Startup Type  Log On As
54, IKE and AuthiP [Psec Keying Modules  The IKEEXT ... Running  Automatic (T.. Local Syste

mmm. & | [ nfor SiW A B Automatic D¢ te

Restart the service - - <

i Infor SIWA (SPWAnyWherelST) Infor SIW A... Running Automatic Local




Appendix F Multiple SIWA WebSphere installations
on a single IBMi server

If you want to install and run multiple instances of SiIWA WebSphere on a single IBMi server using
unique ports for each individual installation, follow these additional settings for each SiWA
installation.

1 Login to IBMi Web Administrator for i using this URL, where <hostname> is the FQDN of the
IBMi server:

http.//<hostname>:2001/HT TPAdmin
For example: http://usalil2m.infor.com:2001/HTTPAdmin)

2 Navigate and select the Net-Link WebSphere Application server, which is used for securing
NetLink.
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http://usalil2m.infor.com:2001/HTTPAdmin
http://usalil2m.infor.com:2001/HTTPAdmin

& 9 C A Notsecure | usaliZminforcom2001/HTTPAdmin

t Apps Suppherfachange Infor OS5 Infor | Wia SW Amyinere XA integrations | 5. M CPQ | SalesPortal Irdor A/EPM

Fledated Liks

oy "ﬁmm1wmlm
'melN\val I‘anagoAll Servers

J Crasse Appi<anan Tarver Al HTTP Servers Al Applcation Servers

Data cumment as of Aug 27 2021 21930 AM
SEVOr o Versicn Status Address:Port Description
Agmunt VBSirtapo ) @ Rusning " 2002
Agming VaSortappawl @ Running ' 2004 2005
Admind VaS(etappa) © Running ' 2006
Admind VES et o) @ Ruoning " 2008
Admundg ViSietagpa) ¥ Running 20N
getauttververt Vo054 Base © Running  * 2008 $060, 5061 5530 S043, 9060 5080, 3443
GetaultWSANWDers V9054 Base ¥ Running  * 2810 5062 5063 3551 9044 9051 5081 9434
St T STiserverT ST V9054Base ® Running  * 2811 5064 5055 5382 0045 9062, 9082 9445
SafaultY STWSAWT ST VRS54 Bare © Running  * 2812 5068 5067 8553 0045 9063 9083 9436
NLAPPSYRINLAPPSVR V9054 Base ® Running  * 10000, 10001.30002 10003 10004 10005 5005610017  Ned-Link Appication Server
MLAPPSYRTSTNLAPPSYRIST VE054Base ® Runaning  * 10020 10021 $0022.50023 10024 10025, 1000610037  Net-Link Appicaion Server
WOLUESS VES(rtappawr) W Stopped  * 12335

Launch the IBM WebSphere Administrative Console to make configuration changes.
1BM Web Administration for |

Setup § m Advanced | Relaled Links

- Rumog )] . Server: [NLAPPSVRINLAPPSVR V9.0 Base v/
¥ Common Tasks and Wizards NLAPPSVR/NLAPPSVR
J Craate Web Services Server
J Create HTTP Server
D Crasts Spphcasion Server Manage WebSphere Application Server - V9.0.5.4 Base
v WAS Wizards Profile: NLAPPSVR  Server: NLAPPSVR
J Creste Virtus! Host
J Instal New Application Product install path: /QIBM/ProdData/WebSphere/AppServer/V9/Base
J Create JDBC Prowider
J Create Data Source
Net-Link Application Server
¥ Server Propertes -
B Propartes . 1 - . .
B SeeTaena SRy n[‘]uy aI=a. = EIESE 3
B View HTTP Servers Create Additional Virtual Host In
The default virtual host "default_nost" was created for this After creating the servel
v Appiications application server. However, you can specify additional virtual applications.
[ Manage Instalied Applications hosts for more control over what URI's can run which applications.
¥ Resource 4
g:m V;:clﬂ:“ﬂ iguratio
J roviders
5 M""O' oo Manage Virtual Hosts Mana
; & default_host @ swaggerul
¥ Web Performa i
Kol noe 9 admin_host ¥ query
¥ Net-Link
v Probiam Datermination © RESTAPIDoCS
D View Logs
4 Wed Log Monitor © ivtApp
& View Create Summary
A Note: To update the status, click [#] Refresh
& Launch Administrative Console
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-\ /—\, WebSphere Integrated
Vo (g ; Solutions Console
'.‘ ) J User ID

e =

coarty of IBM (¢) Copynghe 1BM Corp. 1557, 2020 ANl Rights Reserved
and WabSphere are trademacks or regiitered trademacks of

~ Tegatered i My 1 Other
s be tracamarks of JBM or sther comparig. A current ligt of
o e Web 3 Coourighe 3nd trademuck nformaton

Utensad Materigly « P
8M

1
i

[}
o
"
°

3 From the menus, select Servers > Server Types > WebSphere Application Servers.

& - C A Notsecure | usalil2m.infor.c
it Apps SupplierExchange Infor OS

| WebSphere.

View: | All tasks v

Welcome
&+ Guided Activities
= Servers

= Server Types
WebSphere application servers

« WebSphere MQ servers

»  Web servers

4 Click on the Net-Link configured WebSphere Application server, and then navigate to Server
Infrastructure > Java and Process Management > Process Definition > Java Virtual
Machine > Custom Properties.

Vo | & 1aeen v I
o Gotnd At Areieablinh satvari
Wae 2 00e 52 vimwr # bt of the pooicrtien parems I8 yout atvroemect and the stetue of aach of thate servert. Ty €30 990 o8 TS Sege £ Shange the
= Servare rana of & peckc sopication Jerver
= Yot yer Typms * edfwrerem
. P )

————n T

At Nama & Node = o Kame & Yersan &
v S s Wau can admugter toe btlewing ressurcan
o Swunee waseny USALILIM_NLASOSVR CEALILIM INFOR.COM Base 9054
* Semamw Toew L
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Server Infrastructure

{=} Java and Process Mznagement

Clzss loager
Process definition

Process execution

@ Administration

Java SDKs

Application servers > NLAPPSVR > Process definition

Use this page to configure a process definition. A process definition defines the command line information necessary 10 star or mitalize & Process,

General Properties Additional Properties

g Visup! Maching
Eoviconmees Eotes
Pros x Tla)
Brocess (o33
kegams and wacng

Executable name

Executadle argumaents

Application servers A

Application servers > NLAPPSYR > Process definition > Java Virtual Machine

Use this page 0 configure advanced Java(T™) virtual maching settings.

Runtime |

General Properties Additional Properties

Suzzem proderties

Cassoath

5 Click New and add a new Custom Property for the JVM to reuse the sessionld.

Application servers > NLAPPSVR > Process definition > Java Virtual Machine > Custom properties

Usze this page 1o specify an arbitrary name and value pain The value that is specified for the name and value pair
configuration properties.

+ Preferences

[N | ooiee |

Specify this information:

o)}

Name




Specify HttpSessionIdReuse for the name of the system property.
Value

Specify true for the value of the system property.

Multiple SIWAW WebSphere installations on a single IBMi server

Application servers > NLAPPSVR > Process definition > Java Virtual Machine > Custom properties > HitpSessionIdReuse

Use this page to specty an arbitrary name and vaiue pair. The value that is specified for the name and value pair is 8 string that can set internal system
configuration properties.

General Properties

* Name
[HrpSessionldReuse
+ Value
[true
Description
|
L Apoly || O« || Reset || Cancel |

7 Click Apply, and then save your changes and restart the Application Server.

= Messages

& Changes have been made to your local configuration. You can:
* Save directly to the master configuration.

» Reyigw changes bafore saving or discarding.

85 The server may need to be restarted for these changes o take effect,

Application servers 7C

Application servers > NLAPPSVR > Process definition > Java Virtual Machine > Custom properties

Use this page 1o specify an ardrary name and value pair. The value that is specified for the name and value par is a string that can set intemal system
configuration properties.

* Preferences

New... | Delete l
0T
Select Name & Value & Description 2
You can administer the following rescurces:
HueSespenicheuse troe

Note: SSO cannot be implemented for the second instance of SiWA, as we are using single
WebSphere for 2 SiWA, which is a limitation.
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Appendix G Enabling MFA on Infor LTR

This section how to enable Multi Factor Authentication. Enable MFA If selected in LTR, the MFA
status of all users of the tenant becomes Enabled. At the time of login, the user is challenged for
a Time-based One-time Password (TOTP) if the user has already registered a device for MFA.
Emails to register MFA devices are automatically sent to all administrators.

After MFA is enabled, users can register MFA devices from user settings through the Infor LTR
Portal.

MFA Configuration in Infor LTR:
1.Login to the Infor LTR

2.In the Upper Right Corner, Click the User icon and choose User Management

3.In the Left Pane, Click the Hamburger button (3 lines), Choose Security Administration > Settings
> General Setting >MFA Configuration

a. Check the Enable MFA
b. Check the Enforce MFA (if you want it enforce)
c. Choose Authentication Method (TOTP)




a
GCarerss Settings
& MFA Configuration ~
BN o
Enablo MFA
Ertorce WA
Authantication Mothod
Tome
pUo
ot L¢
o C
& Appication Specific Settings -
< »

d. Click Save
4. Go to Infor LTR installed Windows Server.

Open STSAdminUI

Go to IDP Connection section

Select the IDP (ADFS) in use

Edit the ADFS setting

check the ‘Enable MFA' check box and Click save

Q20T

e R L

ADFS

Partner Entity ID *

hitp://lUKFAVWINFOROS20.infor.com/adfs/s¢

Description

Enable MFA
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User MFA Settings:

1.Goto Infor LTR >User Settings >Security Settings >Click-On MFA Settings

0 Venkata Chaitanya Kris...

Admin Settings

User Settings

User Management

2.Click-On Add New MFA & then Select TOTP

User Settings

Profile Info MFA Settings
Localization Settings -+ Add New MFA v
Out of Office Settings TotP

Notifications and Prompts Settings

\J

Security Settings

Client Access Grant

Now Provide the Device Name & Scan the QR Code using Microsoft Authenticator Application in
your mobile.




Add New Device

P~
@
MFA Registration TOTP Validation MFA Summary

MFA Registration

Device Name

CK

- Download the TOTP authenticator app on your mabile.
I «  Faliow the instructions provided in the app.

+ Choose the Scan QR code option

Enter the TOTP, click ‘Next’ to view ‘MFA Registration Completed’ screen and click ‘Finish’

Add New Device

)
L C

MFA Registration TOTP Vvalidation MFA Summary

MFA TOTP Validation

Entered Device Name:

Enter the 6-digit TOTP that you see in the app

Add New Device

MFA Registration TOTP Validation

MFA Registration Completed

Entered Device Name:

©

MFA Added Successfully
From now on, you will be prompted to enter an MFA verification code after the logon prompt.

When you First Login to Infor LTR, you will be prompted to Enter TOTP.
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F

venkatachaitanyakrishna kaja@infor.com

For added security, we need to further verify your
account.

Enter the TOTP from the CK for MFA
authentlcatlon.

ENTER THE 6-DIGIT CODE




